# Table of Contents

**EasyVR Module** .................................................................................................................. 5

- Product Description ........................................................................................................... 5
- EasyVR 2.0 Features .......................................................................................................... 5

**Technical specifications** ................................................................................................ 6

- Physical dimensions and pin assignment ........................................................................ 6
- Recommended Operating Conditions ............................................................................. 7
- Electrical Characteristics ................................................................................................. 7
- Power Supply Requirements ............................................................................................. 7
- Serial Interface ................................................................................................................ 7
- Microphone ..................................................................................................................... 8
- Audio Output .................................................................................................................. 9
- General Purpose I/O ........................................................................................................ 10
- Flash Update .................................................................................................................. 11

**Quick start for using the module** ..................................................................................... 13

- EasyVR Development Board ........................................................................................ 13
- EasyVR on Arduino ......................................................................................................... 14
- EasyVR on Arduino Pro Mini .......................................................................................... 17
- EasyVR on Basic Stamp .................................................................................................. 17
- EasyVR on Arduino Mega ............................................................................................... 18
- EasyVR on Arduino Leonardo ...................................................................................... 18

**EasyVR Shield for Arduino** .................................................................................................. 19

- Technical specifications ................................................................................................ 19
- Physical dimensions and pin assignment ........................................................................ 19
- Recommended Operating Conditions ............................................................................. 20
- Jumper settings ............................................................................................................... 20
- LEDs ................................................................................................................................ 20

**Quick start guide for using the Shield** ............................................................................. 21

- With Arduino Leonardo .................................................................................................. 21
- With Arduino 2009 – Uno – Mega .................................................................................. 21

**EasyVR Programming** ....................................................................................................... 23

- Communication Protocol ............................................................................................... 23
  - Introduction .................................................................................................................. 23
  - Arguments Mapping .................................................................................................... 24
  - Command Details ........................................................................................................ 25
  - Status Details .............................................................................................................. 30

**Communication Examples** .................................................................................................. 33

- Recommended wake up procedure ................................................................................. 33
- Recommended setup procedure ...................................................................................... 33
- Recognition of a built-in or custom SI command .......................................................... 34
- Adding a new SD command ............................................................................................ 34
- Training an SD command ............................................................................................... 35
- Recognition of an SD command ..................................................................................... 35
- Read how many commands in a group .......................................................................... 36
- Read a user defined command group ............................................................................ 36
- Use general purpose I/O pins ........................................................................................ 37
- Use custom sound playback ........................................................................................... 37
Read sound table ........................................................................................................... 37
Built-in Command Sets ................................................................................................. 38
Error codes ..................................................................................................................... 39
Protocol header file ....................................................................................................... 40
EasyVR Arduino Library Documentation ......................................................................... 41
EasyVR Class Reference ................................................................................................. 41
  Public Types ................................................................................................................. 41
  Public Member Functions ............................................................................................. 41
  Detailed Description ..................................................................................................... 42
  Member Enumeration Documentation ......................................................................... 42
  Constructor & Destructor Documentation .................................................................. 45
  Member Function Documentation ............................................................................... 45
EasyVRBridge Class Reference ....................................................................................... 53
  Public Member Functions ............................................................................................. 53
  Detailed Description ..................................................................................................... 53
  Member Function Documentation ............................................................................... 54
EasyVR Commander ........................................................................................................ 55
  Getting Started ........................................................................................................... 55
  Speech Recognition ...................................................................................................... 56
  Recognition Settings .................................................................................................... 58
  Phone Tones Generation (DTMF) ................................................................................ 59
  Testing SonicNet™ ....................................................................................................... 59
  Using Custom Data ....................................................................................................... 61
    Sound Table ................................................................................................................ 61
    Speaker Independent Custom Vocabularies .............................................................. 62
    Updating Custom Data ............................................................................................... 63
  Updating Firmware ........................................................................................................ 65
  Troubleshooting ............................................................................................................ 65
  Downloading custom data or update fails ................................................................. 65
How to get support ......................................................................................................... 66
## Document History Information

<table>
<thead>
<tr>
<th>Revision</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
</table>
| 3.6.7    | 26.03.2015 | - Updated protocol documentation  
- Fixed and updated EasyVR Commander screenshots  
- Added recognition settings description |
| 3.6.6    | 01.04.2014 | - Updated documentation for the new Arduino Library  
- Added software support for Arduino Leonardo  
- Added warning for using the Shield on non-5V systems |
| 3.6.5    | 25.11.2013 | - Added Arduino Mega and Arduino Leonardo |
| 3.6.4    | 20.11.2013 | - Minor corrections and footnotes updated |
| 3.6.3    | 18.11.2013 | - Changed connection diagram Arduino Uno / BasicStamp.  
- Added more diagrams.  
- Added Arduino Pro mini.  
- Added note to function embedToken.  
- Removed Robonova. |
| 3.6.2    | 6.11.2013  | - Fixed cross-references  
- Updated pictures of new module version |
| 3.6.1    | 5.11.2013  | - Updated Arduino Library documentation |
| 3.6      | 23.07.2013 | - Updated documentation for firmware version 2 additions (custom grammars, SonicNet and DTMF) |
| 3.4.2    | 14.11.2012 | - Troubleshooting Section added  
- Troubleshooting Soundtable download. |
| 3.4.1    | 9.10.2012  | - Document History Information added  
- EasyVR DK added |
| 3.4      | 8.10.2012  | - Added CMD_COUNT_SD  
- Added protocol examples |
| 3.3      | Before October 2012 | - Original Document |
EasyVR Module

Product Description

EasyVR 2.0 is a multi-purpose speech recognition module designed to easily add versatile, robust and cost effective speech recognition capabilities to almost any application.

The EasyVR 2.0 module can be used with any host with an UART interface powered at 3.3V – 5V, such as PIC and Arduino boards. Some application examples include home automation, such as voice controlled light switches, locks, curtains or kitchen appliances, or adding “hearing” to the most popular robots on the market.

EasyVR 2.0 Features

- Supports up to 28 custom Speaker Independent (SI) command vocabularies\(^1\)\(^2\) (new to EasyVR 2.0)
  - Supported Languages:
    - US English
    - UK English
    - German
    - French
    - Italian
    - LA Spanish
    - Korean
    - Japanese
- Supports up to 32 user-defined Speaker Dependent (SD) triggers or commands as well as Voice Passwords. SD custom commands can be spoken in ANY language.
- A variety of built-in Speaker Independent (SI) commands for ready to run basic controls, in the followings languages:
  - English (US)
  - Italian
  - German
  - French
  - Spanish
  - Japanese
- SonicNet technology for wireless communications between modules or any other sound source (Audio CD, DVD, MP3 Player)\(^2\) (new to EasyVR 2.0)
- DTMF tone generation\(^2\) (new to EasyVR 2.0)
- Easy-to-use and simple Graphical User Interface to program Voice Commands and audio.
- Module can be used with any host with an UART interface (powered at 3.3V - 5V)
- Simple and robust documented serial protocol to access and program through the host board
- 3 x GPIO lines (IO1, IO2, IO3) that can be controlled by new protocol commands.
- PWM audio output that directly supports 8Ω speakers.
- Sound playback of up to 9 minutes of recorded sounds or speech.

---

\(^1\) A **QuickT2SI™ Lite** license (sold separately) is required to enable creation of Speaker Independent vocabularies (maximum 12 commands per set).

\(^2\) Custom Speaker Independent vocabularies, SonicNet™ and DTMF generation are available since firmware version 2 (a free update from version 1 is available for download).
## Technical specifications

### Physical dimensions and pin assignment

<table>
<thead>
<tr>
<th>Connector</th>
<th>Number</th>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>J1</td>
<td>1</td>
<td>GND</td>
<td>-</td>
<td>Ground</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>VCC</td>
<td>I</td>
<td>Voltage DC input</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>ERX</td>
<td>I</td>
<td>Serial Data Receive (TTL level)</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>ETX</td>
<td>O</td>
<td>Serial Data Transmit (TTL level)</td>
</tr>
<tr>
<td>J2</td>
<td>1-2</td>
<td>PWM</td>
<td>O</td>
<td>Differential audio output (can directly drive 8Ω speaker)</td>
</tr>
<tr>
<td>J3</td>
<td>1</td>
<td>MIC_RET</td>
<td>-</td>
<td>Microphone reference ground</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>MIC_IN</td>
<td>I</td>
<td>Microphone input signal</td>
</tr>
<tr>
<td>J4</td>
<td>1</td>
<td>/RST</td>
<td>I</td>
<td>Active low asynchronous reset (internal 100K pull-up)</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>/XM</td>
<td>I</td>
<td>Boot select (internal 1K pull-down)</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>IO1</td>
<td>I/O</td>
<td>General purpose I/O (3.0 VDC TTL level)</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>IO2</td>
<td>I/O</td>
<td>General purpose I/O (3.0 VDC TTL level)</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>IO3</td>
<td>I/O</td>
<td>General purpose I/O (3.0 VDC TTL level)</td>
</tr>
</tbody>
</table>

**Note:** the GPIO (J4.3, J4.4, and J4.5) are at nominal 3.0VDC level. Do not connect 5VDC directly to these pins!
### Recommended Operating Conditions

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Parameter</th>
<th>Min</th>
<th>Typ</th>
<th>Max</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>VCC</td>
<td>3.3</td>
<td>5.0</td>
<td>5.5</td>
<td>V</td>
</tr>
<tr>
<td></td>
<td>Ta</td>
<td>0</td>
<td>25</td>
<td>70</td>
<td>°C</td>
</tr>
<tr>
<td></td>
<td>ERX</td>
<td>0</td>
<td>-</td>
<td>VCC</td>
<td>V</td>
</tr>
<tr>
<td></td>
<td>ETX</td>
<td>0</td>
<td>-</td>
<td>VCC</td>
<td>V</td>
</tr>
</tbody>
</table>

### Electrical Characteristics

These are applicable to J4 pins only, including IO1-3, /XM and /RST.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Parameter</th>
<th>Min</th>
<th>Typ</th>
<th>Max</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>( V_{IH} )</td>
<td>2.4</td>
<td>3.0</td>
<td>3.3</td>
<td>V</td>
</tr>
<tr>
<td></td>
<td>( V_{IL} )</td>
<td>-0.1</td>
<td>0.0</td>
<td>0.75</td>
<td>V</td>
</tr>
<tr>
<td></td>
<td>( I_{IL} )</td>
<td>&lt;1</td>
<td></td>
<td>10</td>
<td>µA</td>
</tr>
<tr>
<td></td>
<td>( R_{PU} )</td>
<td></td>
<td>10</td>
<td></td>
<td>kΩ</td>
</tr>
<tr>
<td></td>
<td>( V_{OH} )</td>
<td>2.4</td>
<td></td>
<td></td>
<td>V</td>
</tr>
<tr>
<td></td>
<td>( V_{OL} )</td>
<td></td>
<td>0.6</td>
<td></td>
<td>V</td>
</tr>
</tbody>
</table>

### Power Supply Requirements

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Parameter</th>
<th>Min</th>
<th>Typ</th>
<th>Max</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>( I_{Sleep} )</td>
<td>&lt;1</td>
<td></td>
<td></td>
<td>mA</td>
</tr>
<tr>
<td></td>
<td>( I_{Oper} )</td>
<td>12</td>
<td></td>
<td></td>
<td>mA</td>
</tr>
<tr>
<td></td>
<td>( I_{Speaker} )</td>
<td>180</td>
<td></td>
<td></td>
<td>mA (RMS)</td>
</tr>
</tbody>
</table>

### Serial Interface

The EasyVR is a "slave" module communicating via an asynchronous serial interface (commonly known as UART interface), with the following features:

- Baud Rate: **9600** (default), 19200, 38700, 57600, 115200
- Frame: **8** Data bits, **No** parity, **1** Stop bit

The receiver input data line is ERX, while the transmitter output data line is ETX. No handshake lines are used.

Example of a serial data frame representing character “A” (decimal 65 or hexadecimal 41):

```
VCC 0V
Idle Start 1 0 0 0 0 0 1 0 Stop Idle
```

See also chapter [Communication Protocol](#) later on this manual for communication details.
Microphone

The microphone provided with the EasyVR module is an omnidirectional electret condenser microphone (Horn EM9745P-382):

- Sensitivity -38dB (0dB=1V/Pa @1KHz)
- Load Impedance 2.2K
- Operating Voltage 3V
- Almost flat frequency response in the range 100Hz – 20kHz

If you use a microphone with different specifications the recognition accuracy may be adversely affected. No other kind of microphone is supported by the EasyVR module.

Note: Vocal commands should be given from about 60cm from the microphone, but you can try at greater distances by talking louder.

Positioning guidelines

Please note that improper acoustic positioning of the microphone will reduce recognition accuracy. Many mechanical arrangements are possible for the microphone element, and some will work better than others. When mounting the microphone in the final device, keep in mind the following guidelines:

1. **Flush Mounting** - The microphone element should be positioned as close to the mounting surface as possible and should be fully seated in the plastic housing. There must be no airspace between the microphone element and the housing. Having such airspace can lead to acoustic resonance, which can reduce recognition accuracy.
2. **No Obstructions, Large Hole** - The area in front of the microphone element must be kept clear of obstructions to avoid interference with recognition. The diameter of the hole in the housing in front of the microphone should be at least 5 mm. Any necessary plastic surface in front of the microphone should be as thin as possible, being no more than 0.7 mm, if possible.

![Diagram showing clear area and internal diaphragm](image)

3. **Insulation** - The microphone should be acoustically isolated from the housing if possible. This can be accomplished by surrounding the microphone element with a spongy material such as rubber or foam. The provided microphone has this kind of insulating foam. The purpose is to prevent auditory noises produced by handling or jarring the device from being “picked up” by the microphone. Such extraneous noises can reduce recognition accuracy.

![Diagram showing good and bad insulation](image)

4. **Distance** - If the microphone is moved from 15 cm to 30 cm from the speaker’s mouth, the signal power decreases by a factor of four. The difference between a loud and a soft voice can also be more than a factor of four. Although the internal preamplifier of the EasyVR compensates for a wide dynamic range of input signal strength, if its range is exceeded, the user application can provide feedback to the speaker about the voice volume (see appendix Error codes).

### Audio Output

The EasyVR audio output interface is capable of directly driving an 8Ω speaker. It can also be connected to an external audio amplifier to drive lower impedance loudspeakers.

**Note:** Connecting speakers with lower impedance directly to the module may permanently damage the EasyVR audio output or the whole module.
It is possible to connect higher impedance loads such as headphones, provided that you scale down the output power according to the speaker ratings, for example using a series resistor. The exact resistor value depends on the headphone power ratings and the desired output volume (usually in the order of 10kΩ).

**Note:** Connecting headphone speakers directly to the EasyVR audio output may damage your hearing.

### General Purpose I/O

Since the EasyVR communication interface takes two pins of the host controller, a few spare I/O pins are provided, which can be controlled with the communication protocol, to get those pins back for basic tasks, such as lighting an LED.

The three I/O pins IO1–IO3 are connected directly to the embedded microcontroller on the EasyVR module, so they are referenced to the internal 3.0V regulated power supply. If you need to interface to circuits using a different supply, there are a number of solutions you can adopt. Some of these are outlined below (here IOn indicates any one of the three I/O pins of the EasyVR).

**Use a pin as an output**

All the I/O pins are inputs with weak internal pull-up after power on. You must explicitly configure a pin before you can use it as an output (see the example code **Use general purpose I/O pins**).

### I/O pin examples

- **I/O pin directly driving a low-current LED**
- **I/O pin connected to high impedance 5V circuit (such as MCU input pin)**
- **I/O pin switching a load on a high voltage line using a 12V relay**
The exact components values in these circuits may vary. You need to calculate required values for your application and choice of components. For example, resistor value for the LED circuit can be calculated approximately as:

$$ R_{LED} = \frac{V_{OH} - V_{LED}}{I_{OH}} $$

Where $V_{LED}$ is the LED forward voltage, as reported on the LED datasheet, at the driving current $I_{OH}$ (see section Electrical Characteristics). Let’s assume a typical low-current LED has a $V_F=1.8V$ at 5mA, the resistor value is:

$$ R_{LED} = \frac{2.4 - 1.8}{0.005} = 120 \text{ ohm} $$

Now stay on the safe side and choose a slightly larger resistor, such as 150Ω.

If you want to drive higher current LEDs, you need a circuit like the second one, where you put the LED between the output resistor and the collector of the NPN transistor.

**Use a pin as an input**

All the I/O pins are inputs with weak internal pull-up after power on or reset. You may also configure the pin to have a strong pull-up or no pull-up at all (see the example code Use general purpose I/O pins).

All these circuits assume the EasyVR pin has been configured with an internal pull-up (passive components value can be adjusted to account for weak or strong pull-up).

Disabling the internal pull-up could be used to put the pin in high-impedance state, for example to simulate a tri-state or open-drain output port.

Again, you should refer to the manufacturer’s datasheet when interfacing any external components and to calculate required resistors values or other passive components.

**Flash Update**

The EasyVR module includes a boot loader that allows to update the firmware and to download new sound tables to the on-board memory.

The *boot mode* is activated by keeping the /XM signal to a high logical level at power on or reset. This can be easily done with a jumper (or switch) taking the signal to a suitable pull-up resistor.

To download a firmware update, a sound table or a custom grammar to the EasyVR, power on the module with the jumper closed. For normal operation, just leave the jumper open. Do not change the jumper position while the module is already powered on. It is safe to change /XM level while the module is reset (/RST low).
The pull-up resistor value to use depends on the VCC power supply voltage. For the voltage of the /XM pin when the jumper is closed (short) the following relation holds (note you have a voltage divider circuit):

\[ V_{XM} = \frac{1K}{R + 1K} \cdot V_{CC} \]

Now if you want /XM to be at 3V (logic high) and solving for \( R \), you get:

\[ R_{PU} = \frac{V_{CC}}{3} \cdot 1000 - 1000 \]

That makes 100Ω for 3.3V and around 680Ω for 5V power supplies. Other kinds of circuit are possible, that is just an example and one of the simplest to realize.

To learn how to download new sound tables or custom grammars to your EasyVR 2.0 module, have a look at the section *Using Custom Data*. 
Quick start for using the module

EasyVR Development Board

The EasyVR DevBoard can be used to program commands and sounds into an EasyVR module and quickly test it. Just put your EasyVR module on top of the DevBoard then connect the microphone and an 8 ohm speaker and you are ready to go. The DevBoard features a Freescale JS8 microcontroller programmed as a USB-Serial adapter to convert data sent between a PC and the EasyVR.

You can also write a test program on your PC, using the serial port as you would on a microcontroller. Also it is possible to upload new firmware and custom sound-tables. Everything is managed automatically by the DevBoard so there is no need to set any jumper: the board enters automatically in bootloader mode when needed.

How to get started

1. Install drivers via double click “EasyVR_DevKit_Setup.exe”
2. If your Install succeeded you will see a new Virtual COM Port in your Device manager as soon as you connect the USB cable to the EasyVR DevKit:

   ![Ports (COM & LPT)](image)
   ![Communications Port (COM1)](image)
   ![EasyVR DevKit (COM26)](image)

   *(The exact COM port number may vary)*

3. Now start the EasyVR Commander Software
4. Choose advised COM Port and click connect
5. Then enjoy your EasyVR!

Hardware Interfaces

Connector J1 is a screw terminals block for differential audio output (can directly drive an 8Ω speaker).

Connector J6 is the audio input interface for connecting the microphone provided with the EasyVR module.

Connector J5 on the DevKit board replicate the GPIOs available on the EasyVR as follows:

<table>
<thead>
<tr>
<th>Connector</th>
<th>Pin</th>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>J5 (DevKit)</td>
<td>1</td>
<td>GND</td>
<td>-</td>
<td>Ground</td>
</tr>
<tr>
<td>J5 (DevKit)</td>
<td>2</td>
<td>IO1</td>
<td>I/O</td>
<td>General purpose I/O (3.0 VDC TTL level)</td>
</tr>
<tr>
<td>J5 (DevKit)</td>
<td>3</td>
<td>IO2</td>
<td>I/O</td>
<td>General purpose I/O (3.0 VDC TTL level)</td>
</tr>
<tr>
<td>J5 (DevKit)</td>
<td>4</td>
<td>IO3</td>
<td>I/O</td>
<td>General purpose I/O (3.0 VDC TTL level)</td>
</tr>
</tbody>
</table>

There is also an indication LED connected to IO1 to display status, which is handled for example by the EasyVR Commander to show the module is listening.
**EasyVR on Arduino**

You can connect the EasyVR module to an Arduino board basically in two ways:

1. **Bridge mode** – You can control the module using a software serial library and connect to the module with the EasyVR Commander from your PC, with the same pin configuration.
2. **Adapter mode** – You can use the Arduino board as a USB/Serial adapter by holding the microcontroller in reset, but you need to change the connections once you want to control the module from the microcontroller.

**Bridge mode**

This is the preferred connection mode, since it allows simple communication with both the Arduino microcontroller and the PC. All the provided examples for Arduino manage the bridge mode automatically when the EasyVR Commander requests a connection.

Automatic bridge mode used to be supported only on Arduino boards with a bootloader implementing EEPROM programming. The latest version of EasyVR Commander (since 3.1.x) and Arduino libraries (since 1.1) does not rely on that feature anymore, so it should work on all Arduino boards.

**Note:** bridge mode cannot be used to download a Sound Table or to perform a flash update. You need to use adapter mode or a true USB/Serial adapter.
**Adapter mode**

This connection scheme has the advantage of working with any Arduino board that has an on-board USB/Serial adapter and not needing a spare input pin to enter bridge mode. Also, it does not rely on the AVR microcontroller to do any software bridge between communication pins, so it can be used to check your hardware in case of connection problems.

Using this method also allows you to download a Sound Table to the EasyVR module, provided you also configure the module to start in *boot mode* (see paragraph *Flash Update*).

This configuration, with Reset shorted to GND, is for connection with the EasyVR Commander. To use the module from the Arduino microcontroller, you need to remove the short (yellow wire) and move the ETX/ERX connection to other pins. The example code uses pin 12 for ETX and pin 13 for ERX, like the above bridge mode.

**Arduino software**

Follow these few steps to start playing with your EasyVR module and Arduino:

1. Connect the EasyVR module to your Arduino board as outlined before
2. If you want audio output, connect an 8Ω speaker to J2 header
3. Connect the supplied microphone to the MIC (J3) connector
5. Connect your Arduino board to your PC via USB.

To check everything is working fine:

1. Make sure you activate bridge mode (either manually or automatically) or you use adapter mode
2. Open the EasyVR Commander and connect to the Arduino serial port (see *Getting Started*).

\(^3\) The Arduino library archive file is installed in the EasyVR Commander program folder.
To download a new sound-table:

1. Power OFF the EasyVR module (for example removing the USB cable)
2. Connect the /XM pin of J4 on the EasyVR module for boot mode (see Flash Update for a possible circuit)
3. Power ON again the EasyVR module and the Arduino board (reconnect the USB cable)
4. Make sure you activate bridge mode (either manually or automatically) or you use adapter mode
5. Open the EasyVR Commander and select the Arduino serial port
6. While disconnected choose “Update Custom Data” from the “Tools” menu (see Using Custom Data)

To test the EasyVR module with your Arduino programming IDE:

1. Make sure you did not activate bridge mode manually
2. Open the example sketch TestEasyVR from your IDE menu “File” > “Examples” > “EasyVR”
3. Upload the sketch and open the “Serial Monitor” window
4. See comments on top of the sketch for usage details

When the EasyVR Commander is connected, you can also generate a template code for Arduino that will use the provided libraries (see EasyVR Arduino Library Documentation). All you need is to write actions for each recognized command and adapt the code to your needs.
EasyVR on Arduino Pro Mini

The EasyVR can run on 3.3V and 5V input like the Arduino Pro Mini from Sparkfun.

EasyVR on Basic Stamp

The EasyVR module can be connected to all *Basic Stamp* 2 series devices following the connection scheme below. This is supported by the EasyVR Commander software with a special “bridge” code running on the *Basic Stamp*, which can be downloaded automatically if not present.

The status LED is used to signal that a recognition task is in progress and the application is listening for a voice command. This is optional and can be omitted.

When connected with the EasyVR Commander you can add and remove custom voice commands, as well as train and test them. You can also generate a template PBASIC code to manage voice recognition, which you can easily customize for your own application.

**Please note:** the download of a sound table through any Basic Stamp 2 controller board is not supported, due to limitations of this hardware setup. You may use an USB/Serial adapter, such as the EasyVR DevBoard or another suitable configuration to update the flash memory of the EasyVR module.
EasyVR on Arduino Mega

EasyVR is compatible with the Arduino Mega. Just line up A5 on the Shield with A5 on the Arduino and do the same with D0. Just as shown below in the picture. Then plugin the Shield as you are used to on any other Arduino board.

![EasyVR on Arduino Mega](image)

EasyVR on Arduino Leonardo

**Please note:**
The use of the EasyVR Commander with Arduino Leonardo is only possible for command creation/training and for testing the EasyVR functions, by using the “bridge” software included with the latest Arduino library (version 1.4 and later).
To update the Flash memory and to load custom grammars/sounds on the EasyVR you may use a normal Arduino board.

The EasyVR Shield can communicate with a Leonardo board the following way:

1. Using Serial1 on pins 0-1 and Jumper in the HW position.

The EasyVR Module can communicate with Arduino Leonardo the following way:

1. Using Serial1 on pins 0-1

2. Using any possible Soft serial setup. Please refer to the following notes for more info:
EasyVR Shield for Arduino

The EasyVR Shield is an Arduino shield integrating the EasyVR module, designed to simplify the EasyVR management for Arduino developers.

Technical specifications

Physical dimensions and pin assignment

<table>
<thead>
<tr>
<th>Connector</th>
<th>Number</th>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>J1, J2</td>
<td></td>
<td></td>
<td></td>
<td>Shield interface, same as on Arduino (Pins 0-1 are in use when J12 is set as UP, PC or HW) (Pins 12-13 are in use when J12 is set as SW)</td>
</tr>
<tr>
<td>J3, J4</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>J9</td>
<td></td>
<td>LINE OUT</td>
<td>O</td>
<td>3.5mm stereo/mono headphone jack (16Ω - 32Ω headphones)</td>
</tr>
<tr>
<td>J10</td>
<td>1-2</td>
<td>SPEAKER</td>
<td>O</td>
<td>Differential audio output (can directly drive an 8Ω speaker)</td>
</tr>
<tr>
<td>J11</td>
<td>1</td>
<td>MIC_IN</td>
<td>I</td>
<td>Microphone input signal</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>MIC_RET</td>
<td>-</td>
<td>Microphone reference ground</td>
</tr>
<tr>
<td>J13</td>
<td>1</td>
<td>GND</td>
<td>-</td>
<td>Ground reference</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>IO1</td>
<td>I/O</td>
<td>General purpose I/O (3.0 VDC TTL level) (Also used for on-board green LED D6)</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>IO2</td>
<td>I/O</td>
<td>General purpose I/O (3.0 VDC TTL level)</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>IO3</td>
<td>I/O</td>
<td>General purpose I/O (3.0 VDC TTL level)</td>
</tr>
</tbody>
</table>

**Note**: the GPIO (J13.2, J13.3, and J13.4) are at nominal 3.0VDC level. Do not connect 5VDC directly to these pins!
**Recommended Operating Conditions**

The EasyVR Shield version 2.0 and earlier is compatible only with Arduino boards at 5V I/O voltage levels.

---

**Warning:** Do not connect the EasyVR Shield to systems with 3.3V I/O levels!

---

You may use the EasyVR Module on systems with an incompatible I/O voltage.

**Jumper settings**

**J12 – Operating mode**

This jumper selects the operating mode of the EasyVR Shield and it can be placed in one of four positions:

- **UP – Flash update mode**
  Use it for firmware updates or to download sound table data to the on-board flash memory from the EasyVR Commander. In this mode, the Arduino controller is held in reset and only the embedded USB/Serial adapter is used. The EasyVR module is set in boot mode.

- **PC – PC connection mode**
  Use it for direct connection with the EasyVR Commander. In this mode, the Arduino controller is held in reset and only the embedded USB/Serial adapter is used.

- **HW – Hardware serial mode**
  Use it for controlling the EasyVR module from your Arduino sketch through the hardware serial port (using pins 0-1).

- **SW – Software serial mode**
  Use it for controlling the EasyVR module from your Arduino sketch through a software serial port (using pins 12-13). You can also connect the EasyVR Commander in this mode, provided that the running sketch implements bridge mode (see libraries).

---

**Note:** on the Arduino Leonardo you can use the jumper only in the HW position, both for Arduino sketches and for connection with the EasyVR Commander. Please make sure you have the latest EasyVR Arduino library (version 1.4 and later).

---

**LEDs**

A green LED (D6) is connected to IO1 pin and can be controlled by the user’s program to show feedback during recognition tasks, for example. This LED is on by default after reset or power up.

The red LED (D5) lights up when you set the shield to flash update mode (see Jumper settings).
Quick start guide for using the Shield

Follow these few steps to start playing with your EasyVR Shield and Arduino:

1. Insert the EasyVR Shield on top of your Arduino board
2. If you want audio output, either wire an 8Ω speaker into the screw terminals (J10) or connect headphones to the 3.5mm output jack (J9)
3. Connect the supplied microphone to the MIC IN (J11) connector
5. Connect your Arduino board to your PC via USB.

With Arduino Leonardo

Test the Shield with Arduino:

1. Make sure the jumper (J12) is in the HW position
2. Open the example sketch TestEasyVR from your IDE menu “File” > “Examples” > “EasyVR”
3. Upload the sketch and open the “Serial Monitor” window
4. Send a question mark “?” (without quotes)
5. After a few seconds you should receive an “EasyVR detected” message

Test the Shield with the EasyVR Commander:

1. Make sure the jumper (J12) is in the HW position
2. Close the serial monitor window in the Arduino IDE
3. Open the EasyVR Commander and connect to the Arduino serial port (see [Getting Started](#))

With Arduino 2009 – Uno – Mega

To check everything is working fine:

1. Make sure the jumper (J12) is in the PC position
2. Open the EasyVR Commander and connect to the Arduino serial port (see [Getting Started](#))

\(^4\) The Arduino library archive file is installed in the EasyVR Commander program folder.
To download a new sound-table:

1. Make sure the jumper (J12) is in the UP position
2. Open the EasyVR Commander and select the Arduino serial port
3. While disconnected choose “Update Custom Data” from the “File” menu (see Using Custom Data)

To test the Shield with your Arduino programming IDE:

1. Set the jumper (J12) in the SW position
2. Open the example sketch TestEasyVR from your IDE menu “File” > “Examples” > “EasyVR”
3. Upload the sketch and open the “Serial Monitor” window
4. See comments on top of the sketch for usage details

Keep in mind that if you have a “bridge” code running (all examples do) on Arduino, you can connect the EasyVR Commander leaving the jumper in the SW position, just make sure the monitor window is closed.

When the EasyVR Commander is connected, you can also generate a template code for Arduino, that will use the provided libraries (see EasyVR Arduino Library Documentation). All you need is to write actions for each recognized command.
EasyVR Programming

Communication Protocol

Introduction

Communication with the EasyVR module uses a standard UART interface compatible with 3.3-5V TTL/CMOS logical levels, according to the powering voltage VCC.

A typical connection to an MCU-based host:

The initial configuration at power on is 9600 baud, 8 bit data, No parity, 1 bit stop. The baud rate can be changed later to operate in the range 9600 - 115200 baud.

The communication protocol only uses printable ASCII characters, which can be divided in two main groups:

- Command and status characters, respectively on the TX and RX lines, chosen among lower-case letters.
- Command arguments or status details, again on the TX and RX lines, spanning the range of capital letters.

Each command sent on the TX line, with zero or more additional argument bytes, receives an answer on the RX line in the form of a status byte followed by zero or more arguments.

There is a minimum delay before each byte sent out from the EasyVR module to the RX line, that is initially set to 20 ms and can be selected later in the ranges 0 - 9 ms, 10 - 90 ms, and 100 ms - 1 s. That accounts for slower or faster host systems and therefore suitable also for software-based serial communication (bit-banging).

Since the EasyVR serial interface also is software-based, a very short delay might be needed before transmitting a character to the module, especially if the host is very fast, to allow the EasyVR to get back listening to a new character.

The communication is host-driven and each byte of the reply to a command has to be acknowledged by the host to receive additional status data, using the space character. The reply is aborted if any other character is received and so there is no need to read all the bytes of a reply if not required.

Invalid combinations of commands or arguments are signaled by a specific status byte, that the host should be prepared to receive if the communication fails. Also a reasonable timeout should be used to recover from unexpected failures.

If the host does not send all the required arguments of a command, the command is ignored by the module, without further notification, and the host can start sending another command.

The module automatically goes to lowest power sleep mode after power on. To initiate communication, send any character to wake-up the module.
Arguments Mapping

Command or status messages sent over the serial link may have one or more numerical arguments in the range -1 to 31, which are encoded using mostly characters in the range of uppercase letters. These are some useful constants to handle arguments easily:

ARG_MIN

`@` (40h) Minimum argument value (-1)

ARG_MAX

`\` (60h) Maximum argument value (+31)

ARG_ZERO

`A` (41h) Zero argument value (0)

ARG_ACK

` ' (20h) Read more status arguments

Having those constants defined in your code can simplify the validity checks and the encoding/decoding process. For example (in pseudo-code):

```pseudo-code
# encode value 5
FIVE = 5 + ARG_ZERO
# decode value 5
FIVE - ARG_ZERO = 5
# validity check
IF ARG < ARG_MIN OR ARG > ARG_MAX THEN ERROR
```

Just to make things clearer, here is a table showing how the argument mapping works:

<table>
<thead>
<tr>
<th>ASCII</th>
<th>'@'</th>
<th>'A'</th>
<th>'B'</th>
<th>'C'</th>
<th>...</th>
<th>'Y'</th>
<th>'Z'</th>
<th>'A'</th>
<th>'['</th>
<th>''</th>
<th>']'</th>
<th>'_'</th>
<th>'***'</th>
</tr>
</thead>
<tbody>
<tr>
<td>HEX</td>
<td>40</td>
<td>41</td>
<td>42</td>
<td>43</td>
<td>...</td>
<td>59</td>
<td>5A</td>
<td>5B</td>
<td>5C</td>
<td>5D</td>
<td>5E</td>
<td>5F</td>
<td>60</td>
</tr>
<tr>
<td>Value</td>
<td>-1</td>
<td>0</td>
<td>1</td>
<td>2</td>
<td>...</td>
<td>24</td>
<td>25</td>
<td>26</td>
<td>27</td>
<td>28</td>
<td>29</td>
<td>30</td>
<td>31</td>
</tr>
</tbody>
</table>
## Command Details

This section describes the format of all the command strings accepted by the module. Please note that numeric arguments of command requests are mapped to upper-case letters (see above section).

### CMD_BREAK

<table>
<thead>
<tr>
<th>'b' (62h)</th>
<th>Abort recognition, training or playback in progress if any or do nothing</th>
</tr>
</thead>
</table>

**Known issues:**
In firmware ID 0, any other character received during recognition will prevent this command from stopping recognition that will continue until timeout or other recognition results.

**Expected replies:** STS_SUCCESS, STS_INTERR

### CMD_SLEEP

<table>
<thead>
<tr>
<th>'s' (73h)</th>
<th>Go to the specified power-down mode</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Sleep mode (0-8):</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 = wake on received character only</td>
</tr>
<tr>
<td>1 = wake on whistle or received character</td>
</tr>
<tr>
<td>2 = wake on loud sound or received character</td>
</tr>
<tr>
<td>3-5 = wake on double clap (with varying sensitivity) or received character</td>
</tr>
<tr>
<td>6-8 = wake on triple clap (with varying sensitivity) or received character</td>
</tr>
</tbody>
</table>

**Expected replies:** STS_SUCCESS, STS_AWAKEN

### CMD_LEVEL

<table>
<thead>
<tr>
<th>'v' (76h)</th>
<th>Set SD level</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Strictness control setting (1-5):</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 = easy</td>
</tr>
<tr>
<td>2 = default</td>
</tr>
<tr>
<td>5 = hard</td>
</tr>
</tbody>
</table>

A higher setting will result in more recognition errors.

**Expected replies:** STS_SUCCESS

### CMD_Knob

<table>
<thead>
<tr>
<th>'k' (6Bh)</th>
<th>Set SI knob to specified level</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Confidence threshold level (0-4):</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 = loosest:more valid results</td>
</tr>
<tr>
<td>2 = typical value (default)</td>
</tr>
<tr>
<td>4 = tightest:fewer valid results</td>
</tr>
</tbody>
</table>

**Note:** knob is ignored for trigger words

**Expected replies:** STS_SUCCESS

### CMD_MIC_DIST

<table>
<thead>
<tr>
<th>'k' (6Bh)</th>
<th>Set the microphone operating distance</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Distance settings (1-3):</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 = “headset” (around 5cm from speaker’s mouth)</td>
</tr>
<tr>
<td>2 = “arms length” (default setting, from about 50cm to 1m)</td>
</tr>
<tr>
<td>3 = “far mic” (up to around 3m)</td>
</tr>
</tbody>
</table>

**Expected replies:** STS_SUCCESS
**CMD_LANGUAGE**

'\' (6Ch) Set SI language

[1] Language:
  0 = English
  1 = Italian
  2 = Japanese
  3 = German
  4 = Spanish
  5 = French

Expected replies: STS_SUCCESS

**CMD_TIMEOUT**

'o' (6Fh) Set recognition timeout

[1] Timeout (-1 = default, 0 = infinite, 1-31 = seconds)

Expected replies: STS_SUCCESS

**CMD_RECOG_SI**

'i' (69h) Activate SI recognition from specified word set

[1] Word set index (0-3)

Expected replies: STS_SIMILAR, STS_TIMEOUT, STS_ERROR

**CMD_TRAIN_SD**

't' (74h) Train specified SD/SV command

[1] Group index (0 = trigger, 1-15 = generic, 16 = password)

[2] Command position (0-31)

Expected replies: STS_SUCCESS, STS_RESULT, STS_SIMILAR, STS_TIMEOUT, STS_ERROR

**CMD_GROUP_SD**

'g' (67h) Insert new SD/SV command

[1] Group index (0 = trigger, 1-15 = generic, 16 = password)

[2] Position (0-31)

Expected replies: STS_SUCCESS, STS_OUT_OF_MEM

**CMD_UNGROUP_SD**

'u' (75h) Remove SD/SV command

[1] Group index (0 = trigger, 1-15 = generic, 16 = password)

[2] Position (0-31)

Expected replies: STS_SUCCESS

**CMD_RECOG_SD**

'd' (64h) Activate SD/SV recognition

[1] Group index (0 = trigger, 1-15 = generic, 16 = password)

Expected replies: STS_RESULT, STS_SIMILAR, STS_TIMEOUT, STS_ERROR
**CMD_ERASE_SD**

'e' (65h)  Erase training of SD/SV command

[1]  Group index (0 = trigger, 1-15 = generic, 16 = password)
[2]  Command position (0-31)

Expected replies: STS_SUCCESS

**CMD_NAME_SD**

'n' (6Eh)  Label SD/SV command

[1]  Group index (0 = trigger, 1-15 = generic, 16 = password)
[2]  Command position (0-31)
[3]  Length of label (0-31)
[4-n]  Text for label (ASCII characters from 'A' to `")

Expected replies: STS_SUCCESS

**CMD_COUNT_SD**

'c' (63h)  Request count of SD/SV commands in the specified group

[1]  Group index (0 = trigger, 1-15 = generic, 16 = password)

Expected replies: STS_COUNT

**CMD_DUMP_SD**

'p' (70h)  Read SD/SV command data (label and training)

[1]  Group index (0 = trigger, 1-15 = generic, 16 = password)
[2]  Command position (0-31)

Expected replies: STS_DATA

**CMD_MASK_SD**

'm' (6Dh)  Request bit-mask of non-empty groups

Expected replies: STS_MASK

**CMD_RESETALL**

'r' (72h)  Reset all commands and groups

'R' (52h)  Confirmation character

Expected replies: STS_SUCCESS

**CMD_ID**

'x' (78h)  Request firmware identification

Expected replies: STS_ID

**CMD_DELAY**

'y' (79h)  Set transmit delay

[1]  Time (0-10 = 0-10 ms, 11-19 = 20-100 ms, 20-28 = 200-1000 ms)

Expected replies: STS_SUCCESS
### CMD_BAUDRATE

<table>
<thead>
<tr>
<th>'a' (61h)</th>
<th>Set communication baud-rate</th>
</tr>
</thead>
</table>
| [1]       | Speed mode:  
  1 = 115200  
  2 = 57600  
  3 = 38400  
  6 = 19200  
  12 = 9600 |

**Expected replies:** STS_SUCCESS

### CMD_QUERY_IO

<table>
<thead>
<tr>
<th>'q' (71h)</th>
<th>Configure, query or modify general purpose I/O pins</th>
</tr>
</thead>
<tbody>
<tr>
<td>[1]</td>
<td>Pin number (1 = pin IO1, 2 = pin IO2, 3 = pin IO3)</td>
</tr>
</tbody>
</table>
| [2]       | Pin mode (0 = output low, 1 = output high, 2 = input*, 3 = input strong**, 4 = input weak***):  
  * High impedance input (no pull-up)  
  **Strong means ~10K internal pull-up  
  ***Weak means ~200K internal pull-up (default after power up) |

**Expected replies:** STS_SUCCESS (mode 0-1), STS_PIN (mode 2-4)

### CMD_PLAY_SX

<table>
<thead>
<tr>
<th>'w' (77h)</th>
<th>Wave table entry playback</th>
</tr>
</thead>
<tbody>
<tr>
<td>[1-2]</td>
<td>Two positive values that form a 10-bit index to the sound table (index = [1] * 32 + [2], 0 = built-in &quot;beep&quot;, 1-1023 = sound index)</td>
</tr>
<tr>
<td>[3]</td>
<td>Playback volume (0-31, 0 = min volume, 15 = full scale, 31 = double gain)</td>
</tr>
</tbody>
</table>

**Expected replies:** STS_SUCCESS, STS_ERROR

### CMD_PLAY_DTMF

<table>
<thead>
<tr>
<th>'w' (77h)</th>
<th>Play a DTMF key tone or dial tone</th>
</tr>
</thead>
<tbody>
<tr>
<td>[1]</td>
<td>Fixed to (-1)</td>
</tr>
<tr>
<td>[2]</td>
<td>Index of phone tone to play (0-9 for digits, 10 for '*' key, 11 for '#' key and 12-15 for extra keys 'A' to 'D', -1 for the dial tone)</td>
</tr>
<tr>
<td>[3]</td>
<td>Tone duration minus 1 (0-31 in 40ms units for keys, in seconds for the dial tone)</td>
</tr>
</tbody>
</table>

**Expected replies:** STS_SUCCESS

### CMD_DUMP_SX

<table>
<thead>
<tr>
<th>'h' (68h)</th>
<th>Read wave table data</th>
</tr>
</thead>
</table>

**Expected replies:** STS_TABLE_SX, STS_OUT_OF_MEM

### CMD_DUMP_SI

<table>
<thead>
<tr>
<th>'h' (68h)</th>
<th>Read custom and built-in grammars data</th>
</tr>
</thead>
<tbody>
<tr>
<td>[1]</td>
<td>Index of SI grammar to read (0-31) or (-1) to get the total count of SI grammars (including the first 4 built-in wordsets)</td>
</tr>
</tbody>
</table>

**Expected replies:** STS_GRAMMAR, STS_COUNT
### CMD_SEND_SN

<table>
<thead>
<tr>
<th>'h' (68h)</th>
<th><strong>Send a SonicNet™ token</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>[1]</td>
<td>Length of token (4 or 8 in bits)</td>
</tr>
<tr>
<td>[4-5]</td>
<td>Two positive values that form a 10-bit delay for token output since the next sound playback (( \text{delay} = [4] * 32 + [5] ), 0 = send immediately, 1-1023 = delay in units of 27.46ms)</td>
</tr>
</tbody>
</table>

**Expected replies:** STS_SUCCESS

### CMD_RECV_SN

<table>
<thead>
<tr>
<th>'h' (68h)</th>
<th><strong>Receive a SonicNet™ token</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>[1]</td>
<td>Length of token (4 or 8 in bits)</td>
</tr>
<tr>
<td>[2]</td>
<td>Rejection level (0-2 = higher values mean fewer results, 1 = default)</td>
</tr>
</tbody>
</table>

**Expected replies:** STS_TOKEN, STS_TIMEOUT
Status Details

Replies to commands follow this format. Please note that numeric arguments of status replies are mapped to upper-case letters (see the related section).

STS_MASK

<table>
<thead>
<tr>
<th>'k' (6Bh)</th>
<th>Mask of non-empty groups</th>
</tr>
</thead>
<tbody>
<tr>
<td>[1-8]</td>
<td>4-bit values that form 32-bit mask, LSB first</td>
</tr>
</tbody>
</table>

In reply to: CMD_MASK_SD

STS_COUNT

<table>
<thead>
<tr>
<th>'c' (63h)</th>
<th>Count of commands or total number of SI grammars</th>
</tr>
</thead>
<tbody>
<tr>
<td>[1]</td>
<td>Integer (0-31 = command/grammar count, -1 = 32 commands/grammars)</td>
</tr>
</tbody>
</table>

In reply to: CMD_COUNT_SD, CMD_DUMP_SI

STS_AWAKEN

| 'w' (77h) | Wake-up (back from power-down mode) |

In reply to: Any character after power on or sleep mode

STS_DATA

<table>
<thead>
<tr>
<th>'d' (64h)</th>
<th>Provide command data</th>
</tr>
</thead>
<tbody>
<tr>
<td>[1]</td>
<td>Training information (-1=empty, 1-6 = training count, +8 = SD/SV conflict, +16 = SI conflict)</td>
</tr>
<tr>
<td></td>
<td>Known issues: In firmware ID 0, command creation/deletion might cause other empty commands training count to change to 7. Treat count values of -1, 0 or 7 as empty training markers. Never train commands more than 2 or 3 times.</td>
</tr>
<tr>
<td>[2]</td>
<td>Conflicting command position (0-31, only meaningful when trained)</td>
</tr>
<tr>
<td>[3]</td>
<td>Length of label (0-31)</td>
</tr>
<tr>
<td>[4-n]</td>
<td>Text of label (ASCII characters from 'A' to `)</td>
</tr>
</tbody>
</table>

In reply to: CMD_DUMP_SD

STS_ERROR

<table>
<thead>
<tr>
<th>'e' (65h)</th>
<th>Signal recognition error</th>
</tr>
</thead>
<tbody>
<tr>
<td>[1-2]</td>
<td>Two positive values that form an 8-bit error code (error = [1] * 16 + [2], see appendix)</td>
</tr>
</tbody>
</table>

In reply to: CMD_RECOG_SI, CMD_RECOG_SD, CMD_TRAIN_SD, CMD_PLAY_SX

STS_INVALID

| 'v' (76h) | Invalid command or argument |

In reply to: Any invalid command or argument

STS_TIMEOUT

| 't' (74h) | Timeout expired |

In reply to: CMD_RECOG_SI, CMD_RECOG_SD, CMD_TRAIN_SD
**STS_INTERR**

'I' (69h)  
Interrupted recognition  
*In reply to:* CMD_BREAK while in training, recognition or playback

**STS_SUCCESS**

'O' (6Fh)  
OK or no errors status  
*In reply to:* CMD_BREAK, CMD_DELAY, CMD_BAUDRATE, CMD_TIMEOUT, CMD_KNOB, CMD_LEVEL, CMD_LANGUAGE, CMD_SLEEP, CMD_GROUP_SD, CMD_UNGROUP_SD, CMD_ERASE_SD, CMD_NAME_SD, CMD_RESETALL, CMD_QUERY_IO, CMD_PLAY_SX

**STS_RESULT**

'R' (72h)  
Recognized SD/SV command or Training similar to SD/SV command  
[1]  
Command position (0-31)  
*In reply to:* CMD_RECOG_SD, CMD_TRAIN_SD

**STS_SIMILAR**

'S' (73h)  
Recognized SI word or Training similar to SI word  
[1]  
Word index (0-31)  
*In reply to:* CMD_RECOG_SI, CMD_RECOG_SD, CMD_TRAIN_SD

**STS_OUT_OF_MEM**

'M' (6Dh)  
Memory error (no more room for commands or sound table not present)  
*In reply to:* CMD_GROUP_SD, CMD_DUMP_SX

**STS_ID**

'X' (78h)  
Provide firmware identification  
[1]  
Version identifier (0)  
*In reply to:* CMD_ID

**STS_PIN**

'P' (70h)  
Provide pin input status  
[1]  
Logic level (0 = input low, 1 = input high)  
*In reply to:* CMD_QUERY_IO

**STS_TABLE_SX**

'D' (64h)  
Provide sound table data  
[1-2]  
Two positive values that form a 10-bit count of entries in the sound table (count = [1] * 32 + [2])  
[3]  
Length of table name (0-31)  
[4-n]  
Text of table name (ASCII characters from 'A' to 'Z')  
*In reply to:* CMD_DUMP_SX
**STS_GRAMMAR**

<table>
<thead>
<tr>
<th>'z' (7Ah)</th>
<th>Provide custom grammar data</th>
</tr>
</thead>
<tbody>
<tr>
<td>[1]</td>
<td>Some flags for this grammar (currently 16 is returned for trigger grammars, 0 for commands)</td>
</tr>
<tr>
<td>[2]</td>
<td>Number of commands in this grammar (0-31)</td>
</tr>
<tr>
<td>[3]</td>
<td>Length of first command label (0-31)</td>
</tr>
<tr>
<td>[4-n]</td>
<td>Text of first command label (ASCII characters from 'A' to '')</td>
</tr>
<tr>
<td>...</td>
<td>Repeat last two fields for all the commands in this grammar</td>
</tr>
</tbody>
</table>

**In reply to:** CMD_DUMP_SI

**STS_TOKEN**

<table>
<thead>
<tr>
<th>'f' (66h)</th>
<th>Detected a SonicNet™ token</th>
</tr>
</thead>
<tbody>
<tr>
<td>[1-2]</td>
<td>Two positive values that form the index of a received token (index = [1] * 32 + [2], 0-15 for 4-bit tokens or 0-255 for 8-bits tokens)</td>
</tr>
</tbody>
</table>

**In reply to:** CMD_RECV_SN
Communication Examples

These are some examples of actual command and status characters exchanged with the EasyVR module by host programs and the expected program flow with pseudo-code sequences. The pseudo-instruction SEND transmits the specified character to the module, while RECEIVE waits for a reply character (a timeout is not explicitly handled for simple commands, but should be always implemented if possible).

Also, the OK and ERROR routines are not explicitly defined, since they are host and programming language dependent, but appropriate code should be written to handle both conditions. Lines beginning with a # (sharp) character are comments.

Please note that in a real programming language it would be best to define some constants for the command and status characters, as well as for mapping numeric arguments, that would be used throughout the program, to minimize the chance of repetition errors and clarify the meaning of the code.

See the Protocol header file for sample definitions that can be used in a C language environment.

Here below all the characters sent and received are written explicitly in order to clarify the communication protocol detailed in the previous sections.

Recommended wake up procedure

```
# wake up or interrupt recognition or do nothing
# (uses a timeout or max repetition count)
DO
SEND 'b'
LOOP UNTIL RECEIVE = 'o'
```

Recommended setup procedure

```
# ask firmware id
SEND 'x'
IF NOT RECEIVE = 'x' THEN ERROR

# send ack and read status (expecting id=0)
SEND ' '
id = RECEIVE
IF id = 'A' THEN
# it’s a VRbot
ELSE IF id = 'B' THEN
# it’s an EasyVR
ELSE
# next generation?
END IF

# set language for SI recognition (Japanese)
SEND 'l'
SEND 'C'
IF RECEIVE = 'o' THEN OK ELSE ERROR

# set timeout (5 seconds)
SEND 'o'
SEND 'F'
IF RECEIVE = 'o' THEN OK ELSE ERROR
```
Recognition of a built-in or custom SI command

```c
# start recognition in wordset 1
SEND 'i'
SEND 'B'

# wait for reply:
# (if 5s timeout has been set, wait for max 6s then abort
# otherwise trigger recognition could never end)
result = RECEIVE

IF result = 's' THEN
    # successful recognition, ack and read result
    SEND ' '
    command = RECEIVE - 'A'
    # perform actions according to command
ELSE IF result = 't' THEN
    # timed out, no word spoken
ELSE IF result = 'e' THEN
    # error code, ack and read which one
    SEND ' '
    error = (RECEIVE - 'A') * 16
    SEND ' '
    error = error + (RECEIVE - 'A')
    # perform actions according to error
ELSE
    # invalid request or reply
    ERROR
END IF
```

Adding a new SD command

```c
# insert command 0 in group 3
SEND 'g'
SEND 'D'
SEND 'A'
IF RECEIVE = 'o' THEN OK ELSE ERROR

# set command label to “ARDUINO_2009”
SEND 'g'
SEND 'D'
SEND 'A'
SEND 'Q'    # name length (16 characters, digits count twice)
SEND 'A'
SEND 'R'
SEND 'D'
SEND 'U'
SEND 'I'
SEND 'N'
SEND 'O'
SEND ' '

# encode each digit with a ^ prefix
# followed by the digit mapped to upper case letters
SEND '^
SEND 'C'
SEND '^
SEND 'A'
SEND '^
SEND 'A'
SEND '^
SEND 'J'
SEND 'J'
IF RECEIVE = 'o' THEN OK ELSE ERROR
```
Training an SD command

```plaintext
# repeat the whole training procedure twice for best results
# train command 0 in group 3
SEND 't'
SEND 'D'
SEND 'A'
# wait for reply:
# (default timeout is 3s, wait for max 1s more then abort)
result = RECEIVE
IF RECEIVE = 'o' THEN
  # training successful
  OK
ELSE IF result = 'r' THEN
  # training saved, but spoken command is similar to
  # another SD command, read which one
  SEND '
  command = RECEIVE - 'A'
  # may notify user and erase training or keep it
ELSE IF result = 's' THEN
  # training saved, but spoken command is similar to
  # another SI command (always trigger, may skip reading)
  SEND ' ' command = RECEIVE - 'A'
  # may notify user and erase training or keep it
ELSE IF result = 't' THEN
  # timed out, no word spoken or heard
ELSE IF result = 'e' THEN
  # error code, ack and read which one
  SEND '
  error = (RECEIVE - 'A') * 16
  SEND '
  error = error + (RECEIVE - 'A')
  # perform actions according to error
ELSE
  # invalid request or reply
  ERROR
END IF
```

Recognition of an SD command

```plaintext
# start recognition in group 1
SEND 'd'
SEND 'B'
# wait for reply:
result = RECEIVE
IF result = 'r' THEN
  # successful recognition, ack and read result
  SEND '
  command = RECEIVE - 'A'
  # perform actions according to command
ELSE IF result = 't' THEN
  # timed out, no word spoken
ELSE IF result = 'e' THEN
  # error code, ack and read which one
  SEND '
  error = (RECEIVE - 'A') * 16
  SEND '
  error = error + (RECEIVE - 'A')
  # perform actions according to error
ELSE
  # invalid request or reply
  ERROR
END IF
```
Read used command groups

```plaintext
# request mask of groups in use
SEND 'm'
IF NOT RECEIVE = 'k' THEN ERROR
# read mask to 32 bits variable
# in 8 chunks of 4 bits each
SEND ' '
mask = (RECEIVE - 'A')
SEND ' '
mask = mask + (RECEIVE - 'A') * 2^4
SEND ' '
mask = mask + (RECEIVE - 'A') * 2^8
...
SEND ' '
mask = mask + (RECEIVE - 'A') * 2^{24}
```

Read how many commands in a group

```plaintext
# request command count of group 3
SEND 'c'
SEND 'D'
IF NOT RECEIVE = 'c' THEN ERROR
# ack and read count
SEND ' '
count = RECEIVE - 'A'
IF count = -1 THEN count = 32
```

Read a user defined command group

```plaintext
# dump command 0 in group 3
SEND 'p'
SEND 'D'
SEND 'A'
IF NOT RECEIVE = 'd' THEN ERROR
# read command data
SEND ' '
training = RECEIVE - 'A'
# extract training count (2 for a completely trained command)
tr_count = training AND 7
# extract flags for conflicts (SD or SI)
tr_flags = training AND 24
# read index of conflicting command (same group) if any
SEND ' '
conflict = RECEIVE - 'A'
# read label length
SEND ' '
length = RECEIVE - 'A'
# read label text
FOR i = 0 TO length - 1
SEND ' '
label[i] = RECEIVE
# decode digits
IF label[i] = '^' THEN
SEND ' '
label[i] = RECEIVE - 'A' + '0'
END IF
NEXT
```
Use general purpose I/O pins

```plaintext
# set IO1 pin to logic low level
SEND 'q'
SEND 'B'
SEND 'A'
IF RECEIVE = 'o' THEN OK ELSE ERROR

# set IO2 pin to logic high level
SEND 'q'
SEND 'C'
SEND 'B'
IF RECEIVE = 'o' THEN OK ELSE ERROR

# set IO2 pin as input with strong pull-up and read state
SEND 'q'
SEND 'C'
SEND 'D'
IF NOT RECEIVE = 'p' THEN ERROR

# ack and read logic level
SEND ' 
pin_level = RECEIVE - 'A'

# set IO3 pin as high impedance input (reading state is optional)
SEND 'q'
SEND 'D'
SEND 'C'
IF NOT RECEIVE = 'p' THEN ERROR
```

Use custom sound playback

```plaintext
# play a beep at full volume (works with any or no table)
SEND 'w'
SEND 'A'
SEND 'A'
SEND 'P'
IF RECEIVE = 'o' THEN OK ELSE ERROR

# play entry 13 at half volume
SEND 'w'
SEND 'A'
SEND 'N'
SEND 'H'
IF RECEIVE = 'o' THEN OK ELSE ERROR

# play entry 123 (=3*32+26) at max volume
SEND 'w'
SEND 'A' + 3
SEND 'A' + 26
SEND 'A' + 31
IF RECEIVE = 'o' THEN OK ELSE ERROR
```

Read sound table

```plaintext
# dump sound table
SEND 'h'
IF NOT RECEIVE = 'h' THEN ERROR

# read count of entries and name length
SEND ' 
count = (RECEIVE - 'A') * 32
SEND ' 
count = count + (RECEIVE - 'A')
SEND ' 
length = RECEIVE - 'A'

# read name text
FOR i = 0 TO length - 1
SEND ' 
label[i] = RECEIVE
NEXT
```
## Built-in Command Sets

In the tables below a list of all built-in commands for each supported language, along with group index (trigger or word set), command index and language identifier to use with the communication protocol.

<table>
<thead>
<tr>
<th>Trigger Word set</th>
<th>Command Index</th>
<th>English (US)</th>
<th>Italian</th>
<th>Japanese (Rōmaji)</th>
<th>German</th>
<th>Spanish</th>
<th>French</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>robot</td>
<td>robot</td>
<td>ロボット robotto</td>
<td>roboter</td>
<td>robot</td>
<td>robot</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>move</td>
<td>vai</td>
<td>進め susu-me</td>
<td>gehe</td>
<td>muévete</td>
<td>bouge</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>turn</td>
<td>gira</td>
<td>曲がれ magare</td>
<td>wende</td>
<td>gira</td>
<td>tourne</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>run</td>
<td>corri</td>
<td>走れ hashire</td>
<td>lauf</td>
<td>corre</td>
<td>cours</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>look</td>
<td>guarda</td>
<td>見ろ miro</td>
<td>schau</td>
<td>mira</td>
<td>regarde</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>attack</td>
<td>attacca</td>
<td>攻撃 kougeki</td>
<td>attacke</td>
<td>ataca</td>
<td>attaque</td>
</tr>
<tr>
<td></td>
<td>6</td>
<td>stop</td>
<td>fermo</td>
<td>止まれ tomare</td>
<td>halt</td>
<td>para</td>
<td>arrête</td>
</tr>
<tr>
<td></td>
<td>7</td>
<td>hello</td>
<td>ciao</td>
<td>こんにちは konnichiwa</td>
<td>hallo</td>
<td>hola</td>
<td>salut</td>
</tr>
<tr>
<td></td>
<td>0</td>
<td>left</td>
<td>a sinistra</td>
<td>左 hidari</td>
<td>nach links</td>
<td>a la izquierda</td>
<td>à gauche</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>right</td>
<td>a destra</td>
<td>右 migi</td>
<td>nach rechts</td>
<td>a la derecha</td>
<td>à droite</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>up</td>
<td>in alto</td>
<td>上 ue</td>
<td>hinauf</td>
<td>arriba</td>
<td>vers le haut</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>down</td>
<td>in basso</td>
<td>下 shita</td>
<td>hinunter</td>
<td>abajo</td>
<td>vers le bas</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>forward</td>
<td>avanti</td>
<td>前 mae</td>
<td>vorwärts</td>
<td>adelante</td>
<td>en avant</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>backward</td>
<td>indietro</td>
<td>後ろ ushiro</td>
<td>rückwärts</td>
<td>atrás</td>
<td>en arrière</td>
</tr>
<tr>
<td></td>
<td>0</td>
<td>zero</td>
<td>zero</td>
<td>ゼロ zero</td>
<td>null</td>
<td>cero</td>
<td>zéro</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>one</td>
<td>uno</td>
<td>一 ichi</td>
<td>eins</td>
<td>uno</td>
<td>un</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>two</td>
<td>due</td>
<td>二 ni</td>
<td>zwei</td>
<td>dos</td>
<td>deux</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>three</td>
<td>tre</td>
<td>三 san</td>
<td>drei</td>
<td>tres</td>
<td>trois</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>four</td>
<td>quattro</td>
<td>四 yon</td>
<td>vier</td>
<td>cuatro</td>
<td>quatre</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>five</td>
<td>cinco</td>
<td>五 go</td>
<td>fünf</td>
<td>cinco</td>
<td>cinq</td>
</tr>
<tr>
<td></td>
<td>6</td>
<td>six</td>
<td>sei</td>
<td>六 roku</td>
<td>sechs</td>
<td>seis</td>
<td>six</td>
</tr>
<tr>
<td></td>
<td>7</td>
<td>seven</td>
<td>sette</td>
<td>七 nana</td>
<td>sieben</td>
<td>siete</td>
<td>sept</td>
</tr>
<tr>
<td></td>
<td>8</td>
<td>eight</td>
<td>otto</td>
<td>八 hachi</td>
<td>acht</td>
<td>ocho</td>
<td>huit</td>
</tr>
<tr>
<td></td>
<td>9</td>
<td>nine</td>
<td>nove</td>
<td>九 kyu</td>
<td>neun</td>
<td>nueve</td>
<td>neuf</td>
</tr>
<tr>
<td></td>
<td>10</td>
<td>ten</td>
<td>dieci</td>
<td>十 jyuu</td>
<td>zehn</td>
<td>diez</td>
<td>dix</td>
</tr>
</tbody>
</table>


## Error codes

Below the list of the most useful error codes that may be returned by training or recognizing commands.

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>03h</td>
<td>ERR_DATACOL_TOO_NOISY</td>
</tr>
<tr>
<td>04h</td>
<td>ERR_DATACOL_TOO_SOFT</td>
</tr>
<tr>
<td>05h</td>
<td>ERR_DATACOL_TOO_LOUD</td>
</tr>
<tr>
<td>06h</td>
<td>ERR_DATACOL_TOO_SOON</td>
</tr>
<tr>
<td>07h</td>
<td>ERR_DATACOL_TOO_CHOPPY</td>
</tr>
<tr>
<td>11h</td>
<td>ERR_RECOG_FAIL</td>
</tr>
<tr>
<td>12h</td>
<td>ERR_RECOG_LOW_CONF</td>
</tr>
<tr>
<td>13h</td>
<td>ERR_RECOG_MID_CONF</td>
</tr>
<tr>
<td>14h</td>
<td>ERR_RECOG_BAD_TEMPLATE</td>
</tr>
<tr>
<td>17h</td>
<td>ERR_RECOG_DURATION</td>
</tr>
<tr>
<td>4Ah</td>
<td>ERR_SYNTH_BAD_VERSION</td>
</tr>
<tr>
<td>4Eh</td>
<td>ERR_SYNTH_BAD_MSG</td>
</tr>
<tr>
<td>80h</td>
<td>ERR_NOT_A_WORD</td>
</tr>
</tbody>
</table>

The first group of codes (03h – 07h) is due to errors in the way of speaking to the EasyVR or disturbances in the acquired audio signal that may depend on the surrounding environment.

The second group (11h – 13h) indicates an insufficient score of the recognized word (from lowest to highest). Acceptance of lower score results may be allowed by lowering the “knob” or “level” settings, respectively for built-in and custom commands (see CMD_KNOB and CMD_LEVEL).

A third group of codes (14h – 17h) reports errors in the stored commands that may be due to memory corruption. We suggest you check power level and connections, then erase all the commands in the faulty group and train them again.

The fourth group (4Ah – 4Eh) deals with errors in the compressed sound data, either because the wrong version of the QuickSynthesis™ tool has been used to generate the sound table or because a not supported compression scheme has been selected (or data is generically invalid).

The last code (80h) means that a word has been recognized that is not in the specified built-in sets. This is due to how Speaker Independent recognition works and should be ignored.
Protocol header file

This file “protocol.h” can be used with applications written in the C language. You can download a recent copy from the VeeaR website.

```c
#ifndef PROTOCOL_H
#define PROTOCOL_H

#define CMD_BREAK     'b' // abort recog or ping
#define CMD_SLEEPP    's' // go to power down
#define CMD_KNOB      'k' // set si knob <1>
#define CMD_MIC_DIST  'k' // set microphone (<1>=-1) distance <2>
#define CMD_LEVEL     'v' // set sd level <1>
#define CMD_LANGUAGE  'l' // set si language <1>
#define CMD_TIMEOUT   'o' // set timeout <1>
#define CMD_RECOG_SI  'i' // do si recog from ws <1>
#define CMD_RECOG_SD  'd' // do sd recog at group <1> (0 = trigger mixed si/sd)
#define CMD_ERASE_SD  'e' // reset command at group <1> pos <2>
#define CMD_NAME_SD   'n' // label command at group <1> pos <2> with length <3> name <4-n>
#define CMD_COUNT_SD  'c' // get count of commands <1> (or number of ws <1>)
#define CMD_DUMP_SD   'p' // read command data at group <1> pos <2>
#define CMD_RESETALL  'r' // reset all commands and groups
#define CMD_ID        'x' // get version id
#define CMD_DELAY     'y' // set transmit delay <1> (log scale)
#define CMD_BUARDATE  'a' // set baud rate <1> (bit time, 1=>115200)
#define CMD_QUERY_SD  'q' // configure, read or write I/O pin <1> of type <2>
#define CMD_PLAY_SX   'w' // wave table entry <1-2> (10-bit) playback at volume <3>
#define CMD_PLAY_DTMF 'w' // play (<1>=-1) dial tone <2> for duration <3>
#define CMD_DUMP_SX   'h' // dump wave table entries
#define CMD_DUMP_SI   'x' // dump si settings for ws <1> (or total ws count if =-1)
#define CMDToSend_SN 'j' // send sonicnet token with bits <1> index <2-3> at time <4-5>
#define CMD_RECV_SN  'f' // receive sonicnet token with bits <1> rejection <2> timeout <3-4>

#define STS_MASK      'k' // mask of active groups <1-8>
#define STS_COUNT     'c' // count of commands <1> (or number of ws <1>)
#define STS_AWAKEN    'w' // back from power down mode
#define STS_DATA      'd' // provide training <1>, conflict <2>, command label <3-35> (counted string)
#define STS_ERROR     'e' // signal error code <1-2>
#define STS_INVALID   'v' // invalid command or argument
#define STS_TIMEOUT   't' // timeout expired
#define STS_INTERR    'i' // back from aborted recognition (see 'break')
#define STS_SUCCESS   'o' // no errors status
#define STS_RESULT    'r' // recognised sd command <1> - training similar to sd <1>
#define STS_SIMILAR   's' // recognised si <1> (in mixed si/sd) - training similar to si <1>
#define STS_OUT_OF_MEM 'm' // no more available commands (see 'group')
#define STS_ID        'x' // provide version id <1>
#define STS_PIN       'p' // return pin state <1>
#define STS_TABLE_SX  'h' // table entries count <1-2> (10-bit), table name <3-35> (counted strings)
#define STS_GRAMMAR   'z' // si grammar: flags <1>, word count <2>, labels... <3-35> (n counted strings)
#define STS_TOKEN     'f' // received sonicnet token <1-2>

// protocol arguments are in the range 0x40 (-1) to 0x60 (+31) inclusive
#define ARG_MIN    0x40
#define ARG_MAX    0x60
#define ARG_ZERO   0x41
#define ARG_ACK    0x20
#endif //PROTOCOL_H
```

A better source of information and a reference protocol implementation for the C/C++ language and can be found in the Arduino Library source.
EasyVR Arduino Library Documentation

EasyVR Class Reference

Public Types

- enum ModuleId { VRBOT, EASYVR, EASYVR2 }
- enum Language { ENGLISH, ITALIAN, JAPANESE, GERMAN, SPANISH, FRENCH }
- enum Group { TRIGGER, PASSWORD }
- enum Wordset { TRIGGER_SET, ACTION_SET, DIRECTION_SET, NUMBER_SET }
- enum Knob { LOOSER, LOOSE, TYPICAL, STRICT, STRICTER }
- enum Level { EASY, NORMAL, HARD, HARDER, HARDEST }
- enum Baudrate { B115200, B57600, B38400, B19200, B9600 }
- enum WakeMode { WAKE_ON_CHAR, WAKE_ON_WHISTLE, WAKE_ON_LOUDSOUND, WAKE_ON_2CLAPS, WAKE_ON_3CLAPS }
- enum ClapSense { CLAP_SENSE_LOW, CLAP_SENSE_MID, CLAP_SENSE_HIGH }
- enum PinConfig { OUTPUT_LOW, OUTPUT_HIGH, INPUT_HIZ, INPUT_STRONG, INPUT_WEAK }
- enum PinNumber { IO1, IO2, IO3 }
- enum SoundVolume { VOL_MIN, VOL_HALF, VOL_FULL, VOL_DOUBLE }
- enum SoundIndex { BEEP }
- enum GrammarFlag { GF_TRIGGER }
- enum RejectionLevel { REJECTION_MIN, REJECTION_AVG, REJECTION_MAX }
- enum ErrorCode { ERR_DATACOL_TOO_LONG, ERR_DATACOL_TOO_NOISY, ERR_DATACOL_TOO_SOFT, ERR_DATACOL_TOO_LOUD, ERR_DATACOL_TOO_SOON, ERR_DATACOL_TOO_CHOPPY, ERR_DATACOL_BAD_WEIGHTS, ERR_DATACOL_BAD_SETUP, ERR_RECOG_FAIL, ERR_RECOG_LOW_CONF, ERR_RECOG_MID_CONF, ERR_RECOG_BAD_TEMPLATE, ERR_RECOG_BAD_WEIGHTS, ERR_RECOG_DURAYS, ERR_T2SI_EXCESS_STATES, ERR_T2SI_BAD_VERSION, ERR_T2SI_OUT_OF_RAM, ERR_T2SI_UNEXPECTED, ERR_T2SI_OVERFLOW, ERR_T2SI_PARAMETER, ERR_T2SI_NN_TOO_BIG, ERR_T2SI_NN_BAD_VERSION, ERR_T2SI_NN_NOT_READY, ERR_T2SI_NN_BAD_LAYERS, ERR_T2SI_TRIG_OOV, ERR_T2SI_TOO_SHORT, ERR_SYNTH_BAD_VERSION, ERR_SYNTH_ID_NOT_SET, ERR_SYNTH_TOO_MANY_TABLES, ERR_SYNTH_BAD_SEN, ERR_SYNTH_BAD_MSG, ERR_CUSTOM_NOTA, ERR_SW_STACK_OVERFLOW, ERR_INTERNAL_T2SI_BAD_SETUP }

Public Member Functions

- EasyVR (Stream &s)
- bool detect ()
- bool stop ()
- int8_t getID ()
- bool setLanguage (int8_t lang)
- bool setTimeout (int8_t seconds)
- bool setKnob (int8_t knob)
- bool setLevel (int8_t level)
- bool setDelay (uint16_t millis)
- bool changeBaudrate (int8_t baud)
- bool sleep (int8_t mode)
- bool addCommand (int8_t group, int8_t index)
- bool removeCommand (int8_t group, int8_t index)
- bool setCommandLabel (int8_t group, int8_t index, const char *name)
- bool eraseCommand (int8_t group, int8_t index)
- bool setGroupMask (uint32_t &mask)
- int8_t getNextWordLabel (char *name)
• void \texttt{trainCommand} (int8\_t group, int8\_t index)
• void \texttt{recognizeCommand} (int8\_t group)
• void \texttt{recognizeWord} (int8\_t wordset)
• bool \texttt{hasFinished} ()
• int8\_t \texttt{getCommand} ()
• int8\_t \texttt{getWord} ()
• int16\_t \texttt{getToken} ()
• int16\_t \texttt{getError} ()
• bool \texttt{isTimeout} ()
• bool \texttt{isConflict} ()
• bool \texttt{isMemoryFull} ()
• bool \texttt{setPinOutput} (int8\_t pin, int8\_t value)
• int8\_t \texttt{getPinInput} (int8\_t pin, int8\_t config)
• void \texttt{detectToken} (int8\_t bits, int8\_t rejection, uint16\_t timeout)
• void \texttt{sendTokenAsync} (int8\_t bits, uint8\_t token)
• bool \texttt{sendToken} (int8\_t bits, uint8\_t token)
• bool \texttt{embedToken} (int8\_t bits, uint8\_t token, uint16\_t delay)
• void \texttt{playSoundAsync} (int16\_t index, int8\_t volume)
• bool \texttt{playSound} (int16\_t index, int8\_t volume)
• bool \texttt{dumpSoundTable} (char *name, int16\_t &count)
• bool \texttt{playPhoneTone} (int8\_t tone, uint8\_t duration)
• bool \texttt{resetAll} ()

**Detailed Description**

An implementation of the EasyVR communication protocol.

**Member Enumeration Documentation**

\begin{enumerate}
\item \texttt{enum ModuleId}
\begin{enumerate}
\item Module identification number (firmware version)
\begin{enumerate}
\item VRBOT Identifies a VRbot module
\item EASYVR Identifies an EasyVR module
\item EASYVR2 Identifies an EasyVR module version 2
\end{enumerate}
\end{enumerate}
\item \texttt{enum Language}
\begin{enumerate}
\item Language to use for recognition of built-in words
\begin{enumerate}
\item ENGLISH Uses the US English word sets
\item ITALIAN Uses the Italian word sets
\item JAPANESE Uses the Japanese word sets
\item GERMAN Uses the German word sets
\item SPANISH Uses the Spanish word sets
\item FRENCH Uses the French word sets
\end{enumerate}
\end{enumerate}
\item \texttt{enum Group}
\begin{enumerate}
\item Special group numbers for recognition of custom commands
\begin{enumerate}
\item TRIGGER The trigger group (shared with built-in trigger word)
\item PASSWORD The password group (uses speaker verification technology)
\end{enumerate}
\end{enumerate}
\end{enumerate}
enum **Wordset**

Index of built-in word sets

**Enumerator:**

- **TRIGGER** *set* The built-in trigger word set
- **ACTION** *set* The built-in action word set
- **DIRECTION** *set* The built-in direction word set
- **NUMBER** *set* The built-in number word set

enum **Knob**

Confidence thresholds for the knob settings, used for recognition of built-in words or custom grammars (not used for the mixed trigger group)

**Enumerator:**

- **LOOSER** Lowest threshold, most results reported
- **LOOSE** Lower threshold, more results reported
- **TYPICAL** Typical threshold (default)
- **STRICT** Higher threshold, fewer results reported
- **STRICTER** Highest threshold, fewest results reported

enum **Level**

Strictness values for the level settings, used for recognition of custom commands (not used for the mixed trigger group)

**Enumerator:**

- **EASY** Lowest value, most results reported
- **NORMAL** Typical value (default)
- **HARD** Slightly higher value, fewer results reported
- **HARDER** Higher value, fewer results reported
- **HARDEST** Highest value, fewest results reported

enum **Baudrate**

Constants to use for baudrate settings

**Enumerator:**

- **B115200** 115200 bps
- **B57600** 57600 bps
- **B38400** 38400 bps
- **B19200** 19200 bps
- **B9600** 9600 bps (default)

enum **WakeMode**

Constants for choosing wake-up method in sleep mode

**Enumerator:**

- **WAKE** _ON_ **CHAR** Wake up on any character received
- **WAKE** _ON_ **WHISTLE** Wake up on whistle or any character received
- **WAKE** _ON_ **LOUDSOUND** Wake up on a loud sound or any character received
- **WAKE** _ON_ **2CLAPS** Wake up on double hands-clap or any character received
- **WAKE** _ON_ **3CLAPS** Wake up on triple hands-clap or any character received

enum **ClapSense**

Hands-clap sensitivity for wakeup from sleep mode. Use in combination with **WAKE** _ON_ **2CLAPS** or **WAKE** _ON_ **3CLAPS**

**Enumerator:**

- **CLAP** _SENSE_ **LOW** Lowest threshold
- **CLAP** _SENSE_ **MID** Typical threshold
- **CLAP** _SENSE_ **HIGH** Highest threshold
enum **PinConfig**

Pin configuration options for the extra I/O connector

**Enumerator:**
- **OUTPUT_LOW** Pin is a low output (0V)
- **OUTPUT_HIGH** Pin is a high output (3V)
- **INPUT_HIZ** Pin is an high impedance input
- **INPUT_STRONG** Pin is an input with strong pull-up (~10K)
- **INPUT_WEAK** Pin is an input with weak pull-up (~200K)

enum **PinNumber**

Available pin numbers on the extra I/O connector

**Enumerator:**
- **IO1** Pin IO1
- **IO2** Pin IO2
- **IO3** Pin IO3

enum **SoundVolume**

Some quick volume settings for the sound playback functions (any value in the range 0-31 can be used)

**Enumerator:**
- **VOL_MIN** Lowest volume (almost mute)
- **VOL_HALF** Half scale volume (softer)
- **VOL_FULL** Full scale volume (normal)
- **VOL_DOUBLE** Double gain volume (louder)

enum **SoundIndex**

Special sound index values, always available even when no soundtable is present

**Enumerator:**
- **BEEP** Beep sound

enum **GrammarFlag**

Flags used by custom grammars

**Enumerator:**
- **GF_TRIGGER** A bit mask that indicate grammar is a trigger (opposed to commands)

enum **RejectionLevel**

Noise rejection level for SonicNet token detection (higher value, fewer results)

**Enumerator:**
- **REJECTION_MIN** Lowest noise rejection, highest sensitivity
- **REJECTION_AVG** Medium noise rejection, medium sensitivity
- **REJECTION_MAX** Highest noise rejection, lowest sensitivity

enum **ErrorCode**

Error codes used by various functions

**Enumerator:**
- **ERR_DATACOL_TOO_LONG** too long (memory overflow)
- **ERR_DATACOL_TOO_NOISY** too noisy
- **ERR_DATACOL_TOO_SOFT** spoke too soft
- **ERR_DATACOL_TOO_LOUD** spoke too loud
- **ERR_DATACOL_TOO_SOON** spoke too soon
- **ERR_DATACOL_TOO_CHOPPY** too many segments/too complex
- **ERR_DATACOL_BAD_WEIGHTS** invalid SI weights
- **ERR_DATACOL_BAD_SETUP** invalid setup
- **ERR_RECOG_FAIL** recognition failed
**Constructor & Destructor Documentation**

**EasyVR** (Stream & s)

Creates an EasyVR object, using a communication object implementing the Stream interface (such as HardwareSerial, or the modified SoftwareSerial and NewSoftSerial).

**Parameters:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>s</td>
<td>the Stream object to use for communication with the EasyVR module</td>
</tr>
</tbody>
</table>

**Member Function Documentation**

**bool detect ()**

Detects an EasyVR module, waking it from sleep mode and checking it responds correctly.

**Return values:**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>true</td>
<td>if a compatible module has been found</td>
</tr>
</tbody>
</table>

**bool stop ()**

Interrupts pending recognition or playback operations.

**Return values:**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>true</td>
<td>if the request is satisfied and the module is back to ready</td>
</tr>
</tbody>
</table>

**int8_t getID ()**

Gets the module identification number (firmware version).

**Return values:**

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>integer</td>
<td>is one of the values in ModuleId</td>
</tr>
</tbody>
</table>
**bool setLanguage (int8_t lang)**

Sets the language to use for recognition of built-in words.

**Parameters:**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>lang</td>
<td>(0-5) is one of values in Language</td>
</tr>
</tbody>
</table>

**Return values:**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>true</td>
<td>if the operation is successful</td>
</tr>
</tbody>
</table>

**bool setTimeout (int8_t seconds)**

Sets the timeout to use for any recognition task.

**Parameters:**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>seconds</td>
<td>(0-31) is the maximum time the module keep listening for a word or a command</td>
</tr>
</tbody>
</table>

**Return values:**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>true</td>
<td>if the operation is successful</td>
</tr>
</tbody>
</table>

**bool setKnob (int8_t knob)**

Sets the confidence threshold to use for recognition of built-in words.

**Parameters:**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>knob</td>
<td>(0-4) is one of values in Knob</td>
</tr>
</tbody>
</table>

**Return values:**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>true</td>
<td>if the operation is successful</td>
</tr>
</tbody>
</table>

**bool setLevel (int8_t level)**

Sets the strictness level to use for recognition of custom commands.

**Parameters:**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>level</td>
<td>(1-5) is one of values in Level</td>
</tr>
</tbody>
</table>

**Return values:**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>true</td>
<td>if the operation is successful</td>
</tr>
</tbody>
</table>

**bool setDelay (uint16_t millis)**

Sets the delay before any reply of the module.

**Parameters:**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>millis</td>
<td>(0-1000) is the delay duration in milliseconds, rounded to 10 units in range 10-100 and to 100 units in range 100-1000</td>
</tr>
</tbody>
</table>

**Return values:**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>true</td>
<td>if the operation is successful</td>
</tr>
</tbody>
</table>
### bool `changeBaudrate (int8_t baud)`

Sets the new communication speed. You need to modify the baudrate of the underlying Stream object accordingly, after the function returns successfully.

**Parameters:**
- `baud` is one of values in `Baudrate`

**Return values:**
- `true` if the operation is successful

### bool `sleep (int8_t mode)`

Puts the module in sleep mode.

**Parameters:**
- `mode` is one of values in `WakeMode`, optionally combined with one of the values in `ClapSense`

**Return values:**
- `true` if the operation is successful

### bool `addCommand (int8_t group, int8_t index)`

Adds a new custom command to a group.

**Parameters:**
- `group` (0-16) is the target group, or one of the values in `#Groups`
- `index` (0-31) is the index of the command within the selected group

**Return values:**
- `true` if the operation is successful

### bool `removeCommand (int8_t group, int8_t index)`

Removes a custom command from a group.

**Parameters:**
- `group` (0-16) is the target group, or one of the values in `#Groups`
- `index` (0-31) is the index of the command within the selected group

**Return values:**
- `true` if the operation is successful

### bool `setCommandLabel (int8_t group, int8_t index, const char * name)`

Sets the name of a custom command.

**Parameters:**
- `group` (0-16) is the target group, or one of the values in `#Groups`
- `index` (0-31) is the index of the command within the selected group
- `name` is a string containing the label to be assigned to the specified command

**Return values:**
- `true` if the operation is successful
bool **eraseCommand** (int8_t *group, int8_t *index)

Erases the training data of a custom command.

**Parameters:**

<table>
<thead>
<tr>
<th>group</th>
<th>(0-16) is the target group, or one of the values in #Groups</th>
</tr>
</thead>
<tbody>
<tr>
<td>index</td>
<td>(0-31) is the index of the command within the selected group</td>
</tr>
</tbody>
</table>

**Return values:**

| true | if the operation is successful |

bool **getGroupMask** (uint32_t & mask)

Gets a bit mask of groups that contain at least one command.

**Parameters:**

| mask    | is a variable to hold the group mask when the function returns |

**Return values:**

| true | if the operation is successful |

int8_t **getCommandCount** (int8_t *group)

Gets the number of commands in the specified group.

**Parameters:**

| group   | (0-16) is the target group, or one of the values in #Groups |

**Return values:**

| integer | is the count of commands (negative in case of errors) |

bool **dumpCommand** (int8_t *group, int8_t *index, char *name, uint8_t & training)

Retrieves the name and training data of a custom command.

**Parameters:**

<table>
<thead>
<tr>
<th>group</th>
<th>(0-16) is the target group, or one of the values in #Groups</th>
</tr>
</thead>
<tbody>
<tr>
<td>index</td>
<td>(0-31) is the index of the command within the selected group</td>
</tr>
<tr>
<td>name</td>
<td>points to an array of at least 32 characters that holds the command label when the function returns</td>
</tr>
<tr>
<td>training</td>
<td>is a variable that holds the training count when the function returns. Additional information about training is available through the functions isConflict() and getWord() or getCommand()</td>
</tr>
</tbody>
</table>

**Return values:**

| true | if the operation is successful |

int8_t **getGrammarsCount** (void)

Gets the total number of grammars available, including built-in and custom.

**Return values:**

| integer | is the count of grammars (negative in case of errors) |
bool **dumpGrammar** (int8_t grammar, uint8_t & flags, uint8_t & count)

Retrieves the contents of a built-in or a custom grammar. Command labels contained in the grammar can be obtained by calling **getNextWordLabel()**.

**Parameters:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>grammar</td>
<td>(0-31) is the target grammar, or one of the values in Wordset</td>
</tr>
<tr>
<td>flags</td>
<td>is a variable that holds some grammar flags when the function returns. See GrammarFlag</td>
</tr>
<tr>
<td>count</td>
<td>is a variable that holds the number of words in the grammar when the function returns.</td>
</tr>
</tbody>
</table>

**Return values:**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>true</td>
<td>if the operation is successful</td>
</tr>
</tbody>
</table>

bool **getNextWordLabel** (char * name)

Retrieves the name of a command contained in a custom grammar. It must be called after **dumpGrammar()**.

**Parameters:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>name</td>
<td>points to an array of at least 32 characters that holds the command label when the function returns</td>
</tr>
</tbody>
</table>

**Return values:**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>true</td>
<td>if the operation is successful</td>
</tr>
</tbody>
</table>

void **trainCommand** (int8_t group, int8_t index)

Starts training of a custom command. Results are available after **hasFinished()** returns true.

**Parameters:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>group</td>
<td>(0-16) is the target group, or one of the values in #Groups</td>
</tr>
<tr>
<td>index</td>
<td>(0-31) is the index of the command within the selected group</td>
</tr>
</tbody>
</table>

**Note:**

The module is busy until training completes and it cannot accept other commands. You can interrupt training with **stop()**.

void **recognizeCommand** (int8_t group)

Starts recognition of a custom command. Results are available after **hasFinished()** returns true.

**Parameters:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>group</td>
<td>(0-16) is the target group, or one of the values in #Groups</td>
</tr>
</tbody>
</table>

**Note:**

The module is busy until recognition completes and it cannot accept other commands. You can interrupt recognition with **stop()**.

void **recognizeWord** (int8_t wordset)

Starts recognition of a built-in word. Results are available after **hasFinished()** returns true.

**Parameters:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>wordset</td>
<td>(0-3) is the target word set, or one of the values in Wordset, (4-31) is the target custom grammar, if present</td>
</tr>
</tbody>
</table>

**Note:**

The module is busy until recognition completes and it cannot accept other commands. You can interrupt recognition with **stop()**.
bool hasFinished ()
Polls the status of on-going recognition, training or asynchronous playback tasks.

Return values:

| true | if the operation has completed |

int8_t getCommand ()
Gets the recognised command index if any.

Return values:

| (0-31) | is the command index if recognition is successful, (-1) if no command has been recognized or an error occurred |

int8_t getWord ()
Gets the recognised word index if any, from built-in sets or custom grammars.

Return values:

| (0-31) | is the command index if recognition is successful, (-1) if no built-in word has been recognized or an error occurred |

int16_t getToken ()
Gets the index of the received SonicNet token if any.

Return values:

| integer | is the index of the received SonicNet token (0-255 for 8-bit tokens or 0-15 for 4-bit tokens) if detection was successful, (-1) if no token has been received or an error occurred |

int16_t getError ()
Gets the last error code if any.

Return values:

| (0-255) | is the error code, (-1) if no error occurred |

bool isTimeout ()
Retrieves the timeout indicator.

Return values:

| true | if a timeout occurred |

bool isConflict ()
Retrieves the conflict indicator.

Return values:

| true | is a conflict occurred during training. To know what caused the conflict, use getCommand() and getWord() (only valid for triggers) |

bool isMemoryFull ()
Retrieves the memory full indicator (only valid after addCommand() returned false).

Return values:

| true | if a command could not be added because of memory size constraints (up to 32 custom commands can be created) |
bool setPinOutput (int8_t pin, int8_t value)

Configures an I/O pin as an output and sets its value

**Parameters:**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>pin</td>
<td>(1-3) is one of values in PinNumber</td>
</tr>
<tr>
<td>pin</td>
<td>(0-1) is one of the output values in PinConfig, or Arduino style HIGH and LOW macros</td>
</tr>
</tbody>
</table>

**Return values:**

<p>| |</p>
<table>
<thead>
<tr>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>true if the operation is successful</td>
</tr>
</tbody>
</table>

int8_t getPinInput (int8_t pin, int8_t config)

Configures an I/O pin as an input with optional pull-up and return its value

**Parameters:**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>pin</td>
<td>(1-3) is one of values in PinNumber</td>
</tr>
<tr>
<td>pin</td>
<td>(2-4) is one of the input values in PinConfig</td>
</tr>
</tbody>
</table>

**Return values:**

<p>| |</p>
<table>
<thead>
<tr>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>integer is the logical value of the pin</td>
</tr>
</tbody>
</table>

void detectToken (int8_t bits, int8_t rejection, uint16_t timeout)

Starts listening for a SonicNet token. Manually check for completion with hasFinished().

**Parameters:**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>bits</td>
<td>(4 or 8) specifies the length of received tokens</td>
</tr>
<tr>
<td>rejection</td>
<td>(0-2) specifies the noise rejection level, it can be one of the values in RejectionLevel</td>
</tr>
<tr>
<td>timeout</td>
<td>(1-28090) is the maximum time in milliseconds to keep listening for a valid token or (0) to listen without time limits</td>
</tr>
</tbody>
</table>

**Note:**

The module is busy until token detection completes and it cannot accept other commands. You can interrupt listening with stop().

void sendTokenAsync (int8_t bits, uint8_t token)

Starts immediate playback of a SonicNet token. Manually check for completion with hasFinished().

**Parameters:**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>bits</td>
<td>(4 or 8) specifies the length of trasmitted token</td>
</tr>
<tr>
<td>token</td>
<td>is the index of the SonicNet token to play (0-255 for 8-bit tokens or 0-15 for 4-bit tokens)</td>
</tr>
</tbody>
</table>

**Note:**

The module is busy until playback completes and it cannot accept other commands. You can interrupt playback with stop().
bool sendToken (int8_t bits, uint8_t token)

Plays a SonicNet token and waits for completion.

**Parameters:**

<table>
<thead>
<tr>
<th>bits</th>
<th>(4 or 8) specifies the length of transmitted token</th>
</tr>
</thead>
<tbody>
<tr>
<td>token</td>
<td>is the index of the SonicNet token to play (0-255 for 8-bit tokens or 0-15 for 4-bit tokens)</td>
</tr>
</tbody>
</table>

**Return values:**

| true     | if the operation is successful |

bool embedToken (int8_t bits, uint8_t token, uint16_t delay)

Schedules playback of a SonicNet token after the next sound starts playing.

**Parameters:**

<table>
<thead>
<tr>
<th>bits</th>
<th>(4 or 8) specifies the length of transmitted token</th>
</tr>
</thead>
<tbody>
<tr>
<td>token</td>
<td>is the index of the SonicNet token to play (0-255 for 8-bit tokens or 0-15 for 4-bit tokens)</td>
</tr>
<tr>
<td>delay</td>
<td>(1-28090) is the time in milliseconds at which to send the token, since the beginning of the next sound playback</td>
</tr>
</tbody>
</table>

**Return values:**

| true     | if the operation is successful |

**Note:**
The scheduled token remains valid for one operation only, so you have to call playSound() or playSoundAsync() immediately after this function.

void playSoundAsync (int16_t index, int8_t volume)

Starts playback of a sound from the sound table. Manually check for completion with hasFinished().

**Parameters:**

<table>
<thead>
<tr>
<th>index</th>
<th>is the index of the target sound in the sound table</th>
</tr>
</thead>
<tbody>
<tr>
<td>volume</td>
<td>(0-31) may be one of the values in SoundVolume</td>
</tr>
</tbody>
</table>

**Note:**
The module is busy until playback completes and it cannot accept other commands. You can interrupt playback with stop().

bool playSound (int16_t index, int8_t volume)

Plays a sound from the sound table and waits for completion.

**Parameters:**

<table>
<thead>
<tr>
<th>index</th>
<th>is the index of the target sound in the sound table</th>
</tr>
</thead>
<tbody>
<tr>
<td>volume</td>
<td>(0-31) may be one of the values in SoundVolume</td>
</tr>
</tbody>
</table>

**Return values:**

| true     | if the operation is successful |

**Note:**
To alter the maximum time for the wait, define the EASYVR_PLAY_TIMEOUT macro before including the EasyVR library.
bool dumpSoundTable (char * name, int16_t & count)

Retrieves the name of the sound table and the number of sounds it contains

Parameters:

<table>
<thead>
<tr>
<th>name</th>
<th>points to an array of at least 32 characters that holds the sound table label when the function returns</th>
</tr>
</thead>
<tbody>
<tr>
<td>count</td>
<td>is a variable that holds the number of sounds when the function returns</td>
</tr>
</tbody>
</table>

Return values:

| true       | if the operation is successful                                                                   |

bool playPhoneTone (int8_t tone, uint8_t duration)

Plays a phone tone and waits for completion

Parameters:

| tone     | is the index of the tone (0-9 for digits, 10 for '*' key, 11 for '#' key and 12-15 for extra keys 'A' to 'D', -1 for the dial tone) |
| duration | (1-32) is the tone duration in 40 milliseconds units, or in seconds for the dial tone               |

Return values:

| true       | if the operation is successful                                                                   |

bool resetAll ()

Empties internal memory for custom commands and groups.

Return values:

| true       | if the operation is successful                                                                   |

Note:

It will take about 35 seconds for the whole process to complete and it cannot be interrupted. During this time the module cannot accept any other command. The sound table and custom grammars data is not affected.

EasyVRBridge Class Reference

Public Member Functions

- bool check ()
- bool checkEEPROM ()
- void loop (uint8_t a_rx, uint8_t a_tx, uint8_t b_rx, uint8_t b_tx)
- void loop (Stream &s)

Detailed Description

An implementation of a software bridge between two series of Rx/Tx pins, that enables routing of the hardware serial port (connected to the PC) to digital I/O pins used as a software serial port (connected to the EasyVR).
Member Function Documentation

`bool check()`
Tests if bridge mode has been requested

**Return values:**
- `true`: if bridge mode should be started

**Note:**
The EasyVR Commander software can request bridge mode using the Serial port. This method does not require to reserve EEPROM locations.

`bool checkEEPROM()`
Tests if bridge mode has been requested (legacy method)

**Return values:**
- `true`: if bridge mode should be started

**Note:**
The first two EEPROM locations (bytes 0-1) are used for discovery and request of bridge mode from the EasyVR Commander software. Do not use the same locations for other program data.

`void loop(uint8_t a_rx, uint8_t a_tx, uint8_t b_rx, uint8_t b_tx)`
Performs bridge mode between port A and B in an endless loop

**Parameters:**
- `a_rx`: is the Rx pin of port A
- `a_tx`: is the Tx pin of port A
- `b_rx`: is the Rx pin of port B
- `b_tx`: is the Tx pin of port B

**Note:**
Bridge mode internally connects Rx:A to Tx:B and Rx:B to Tx:A. This is done by reading from a pin and writing to the other in a fast loop, that runs until the microcontroller is reset.

`void loop(Stream & s)`
Performs bridge mode between the PC Serial port and the specified port in a continuous loop. It can be aborted by sending a question mark (`?`).

**Parameters:**
- `s`: is the target serial port

**Note:**
You can use this alternate loop on boards that don't have a separate USB/Serial adapter, such as Arduino Leonardo.
**EasyVR Commander**

The EasyVR Commander software can be used to easily configure your EasyVR module connected to your PC through an adapter board, or by using the microcontroller host board with the provided “bridge” program (available for ROBONOVA controller board, Arduino 2009/UNO, Parallax Basic Stamp).

You can define groups of commands or passwords and generate a basic code template to handle them. It is required to edit the generated code to implement the application logic, but the template contains all the functions or subroutines to handle the speech recognition tasks.

**Getting Started**

Connect the adapter board or a microcontroller host board with a running “bridge” program\(^5\) to your PC, and then check that all devices are properly turned on and start the EasyVR Commander. Select the serial port to use from the toolbar or the “File” menu, and then go with the “Connect” command.

There are four kinds of commands in the software (see Figure 1 and Figure 4):

- **Trigger** - is a special group where you have the built-in SI trigger word “Robot” and you may add one user-defined SD trigger word. Trigger words are used to start the recognition process
- **Group** - where you may add user-defined SD commands
- **Password** - a special group for “vocal passwords” (up to five), using Speaker Verification (SV) technology
- **Wordset** - built-in set of SI commands (for instance in Figure 1 above, the Wordset 1 is selected)

\(^5\) On some systems the EasyVR Commander can automatically upload the “bridge” program to the host board once connected. That applies to Robonova controller board and Parallax Basic Stamp.
Speech Recognition

The recognition function of the EasyVR works on a single group at a time, so that users need to group together all the commands that they want to be able to use at the same time.

When EasyVR Commander connects to the module, it reads back all the user-defined commands and groups, which are stored into the EasyVR module non-volatile memory.

You can add a new command by first selecting the group in which the command needs to be created and then using the toolbar icons or the “Edit” menu.

A command should be given a label and then it should be trained twice with the user's voice: the user will be guided throughout this process (see Figure 2) when the “Train Command” action is invoked.

Note: Only Latin characters and digits can be used for labels, as well as the underscore character.

![Guided training dialog](image)

Figure 2 – Guided training dialog

After clicking on “Phase 1” or “Phase 2” buttons, remember you have to start speaking only when you see this little window:

![Speak now...](image)

If any error happens, command training will be cancelled. Errors may happen when the user's voice is not heard correctly, there is too much background noise or when the second word heard is too different from the first one.

![Alert dialog in case of conflict](image)

Figure 3 – Alert dialog in case of conflict
The software will also alert if a command is too similar to an existing one by specifying the index of the conflicting command in the "Conflict" column. For example, in the following Figure 4 the command "TEST_CMD_ONE" sounds too similar to "TEST_CMD_ZERO" (i.e. they have been trained with a similar pronunciation).

**Note:** TEST_CMD_ZERO and TEST_CMD_ONE are just examples of labels, you should use label names that reflects the real command that you are going to train.

![Figure 4 – Conflicting commands](image)

The current status is displayed in the EasyVR Commander list view where groups that already contain commands are highlighted in bold.

The selected group of commands can also be tested, by using the icon on the toolbar or the “Tools” menu, to make sure the trained commands can be recognized successfully.

**Note:** If you want to re-train a command you need to erase the previous training first.

**Note:** "Vocal passwords" (Group 16) are much more sensitive to environment noise and distance from the microphone: be sure to train and to verify the password in similar conditions.
Recognition Settings

The module comes programmed with some default settings that can affect voice recognition. These parameters can be altered in those cases where the default values do not offer the best performance.

The first two parameters ("Level" and "Knob") affect the way recognition results are evaluated and reported, each one for a different kind of voice recognition algorithm (Speaker Dependent / Verification and Speaker Independent).

Both these values are used for a sort of acceptance threshold: each word or command recognized is assigned a score by the algorithm, which is compared to the threshold.

In some situations the algorithm may flag a correct result as an error or a low confidence result. In those cases you may try to lower the threshold and allow more results to be reported as correct. The drawback is that even words that were correctly refused before, now might also be accepted.

The vice-versa is also true: you can increase the threshold to avoid some incorrect words to be reported as good, but then you may also lose a few correct results. So, in the end, you need to find the best compromise.

The last parameter affect the internal microphone pre-amplifier and AGC (Automatic Gain Control) stages and is an indication of the expected operating distance of the microphone from the speaker's mouth.

![Recognition Settings Interface](image)

*Figure 5 - Interface for changing recognition settings*

To change the recognition settings of the currently connected EasyVR device press the "Apply" button. The window is non-modal, so you can test the effects of your changes while leaving it open.

The "Save" button makes the EasyVR Commander remember your settings and automatically apply them to every connected device. The module itself does not store any option.
Phone Tones Generation (DTMF)

The EasyVR module is also capable of generating DTMF sounds. This feature can be tested by using the "Dial Tones" command in the "Tools" menu.

The tone duration can be specified in increments of 40 ms (milliseconds). The dial tone has a fixed duration of 3 seconds (its duration can be modified when programming the EasyVR).

Testing SonicNet™

Another feature available from the "Tools" menu is the "SonicNet", a wireless communication protocol based on transmission and detection of special sequences of tones, called "tokens".

Two kinds of tokens can be selected: a short version, with up to 16 different tokens, and a long version that provides up to 256 tokens.

The EasyVR module can listen for incoming tokens continuously, or for as long as about 28 seconds
One parameter for token detection is the rejection level that specifies the receiver sensitivity: higher rejection means lower sensitivity that is a lower detection rate, and vice-versa.

When the timeout parameter is set to 0, the module will listen continuously and you can use the “Play” button to send a token from your PC soundcard and the “Stop” button to stop listening.

**Figure 8 - Modified interface during continuous listening**

A prompt window will display the current state of token detection:

- **Continuous listening...**
- **Received Token 5. Now listening...**

Tokens may also be transmitted from the module with the “Send” button. An optional delay parameter can be used to indicate that the token will be mixed with the next sound played from the Soundtable, after the specified amount of time since the playback begins. In this case the SonicNet dialog will close to let you choose a sound to play back.

**Note:** If you want to mix tokens with a compressed audio sample, you must use a compression scheme with a sample rate of 9.3kHz when building the Soundtable in the QuickSynthesis™ tool.

If the delay is 0, the token is sent out immediately. Other values can be specified up to around 28 seconds of delay (with a granularity of around 27.5 ms).

Finally, you can also export all the tokens of the specified length to some folder on your PC as Wave files (.WAV format) by using the “Generate...” button. You can then use those files to embed SonicNet™ tokens into other software or external sound sources (such as portable players, CDs or DVDs, etc...).
More details about this technology can be found in Sensory’s application note 80-0307-B, available at their website (http://www.sensoryinc.com/support/docs/80-0307-B.pdf).

Using Custom Data

Sound Table

The EasyVR module can play one of the sounds or sentences saved on its internal flash memory. A predefined “beep” sound is also always available, even when no sounds have been downloaded to the module.

The custom sounds are organized in a so-called “sound table” that users can prepare and build with the special QuickSynthesis™ tool. Please refer to this application’s own manual for details about the creation of a sound table. Let’s summarize the basic steps here:

- Prepare the audio files you want to include in the sound table in WAV format, uncompressed 16-bit 22050Hz mono. To create the sound files you may use a free software like Audacity for example (http://audacity.sf.net)
- Open Sensory’s QuickSynthesis™ 5 and create a new project, specifying “RSC4 family”
- Add your WAV files and specify one of the supported compression scheme (see table below)
- Optionally add sentences, by combining basic WAV sounds. That allows you to save memory when you have speech audio files, if they share some pieces (like “You said” + “One”, “You said” + “Two”, and so on)
- Build the project with QuickSynthesis™ and use default settings (“Build linkable module”, “Load in CONST space”, “Load above or at: 0’). You will be asked to recompress new or modified sound files, just confirm and proceed
- Now save your project and build it once again, so that the EasyVR Commander will see that your build is up to date.

The audio compression formats supported by the EasyVR module (from highest to lowest compression rate):

<table>
<thead>
<tr>
<th>Compression Scheme</th>
<th>Available Time (8kHz 15% silence)</th>
<th>Available Time (9.3kHz 15% silence)</th>
</tr>
</thead>
<tbody>
<tr>
<td>SX-2</td>
<td>8.7 minutes</td>
<td>7.5 minutes</td>
</tr>
<tr>
<td>SX-3</td>
<td>7.6 minutes</td>
<td>6.6 minutes</td>
</tr>
<tr>
<td>SX-4</td>
<td>6.8 minutes</td>
<td>5.9 minutes</td>
</tr>
<tr>
<td>SX-5</td>
<td>6.1 minutes</td>
<td>5.2 minutes</td>
</tr>
<tr>
<td>SX-6</td>
<td>5.6 minutes</td>
<td>4.8 minutes</td>
</tr>
<tr>
<td>4-bit ADPCM</td>
<td>87 seconds</td>
<td>N/A</td>
</tr>
<tr>
<td>8-bit PCM</td>
<td>45 seconds</td>
<td>38 seconds</td>
</tr>
</tbody>
</table>
For audio file containing speech, the SX-3 compression is usually a good choice. If you need higher quality try lower compression rates. Please note that due to the sampling rate used, the audio files cannot contain very high frequencies (less than half the sampling rate).

**Figure 10 - External tool for creating a Soundtable**

**Note:** Only one Soundtable can be downloaded to the EasyVR module, so make sure you include all the sounds you want to use in a single project.

**Speaker Independent Custom Vocabularies**

The set of built-in Speaker Independent recognition vocabularies can be expanded with custom grammars, that you can create with the QuickT2SI™ tool (a separate license is required to use the software).

When you create a QuickT2SI™ project, you are presented with a list of words or short phrases (also called “commands”) and an optional trigger word/phrase. The so-called “trigger” is a special set that contains only one word or phrase, with an improved recognition performance, that is used as an entry point for any vocal interaction with a device that is continuously listening to the user’s voice.

If you need to use a trigger word, it is important to carefully choose it so that it has good performance, with very few unintended activations and a high recognition rate. When the user says the trigger word followed by a command, the system can discard unintended activations when the trigger is not followed by a command within a short amount of time (usually around 3 seconds). Moreover, there is only one trigger word to listen to, instead of a list of several commands, so the chance to pick up a random command from background noise or talk is also lower, when using a trigger word.

For assistance on using the QuickT2SI™ Software, please refer to the software help file.
Several projects can also be combined together if they are using the same acoustic model (language data) using the Acoustic Model Combiner included with the tool. This is useful if you have many command vocabularies, in order to save space in the EasyVR memory.

**Updating Custom Data**

Once the sound table and/or custom recognition grammars have been created, they can be processed by the EasyVR Commander and downloaded to the module. Note that you must first disconnect from the module and do the steps required to start it in “boot-mode” (see the section Flash Update).

Now the command “Update Custom Data” is enabled, either on the toolbar or the “File” menu, and it can be used to start the update process. First you are required to list all the QuickSynthesis™ and QuickT2SI™ projects you want to use. A new file containing the specified custom data will be generated and the contents will be displayed, so that you can verify them before updating the module.

**Note:** The projects must have been built already with the QuickSynthesis™ or the QuickT2SI™ tool, before the custom data generation can be completed successfully. If a recent build is not available you will receive a warning message, the project files can be opened in their respective tools and a fresh build started (make sure the project file has been saved before the build).

Once back in the EasyVR Commander the project can be reloaded by pressing the “Refresh” button. If the process completes successfully, the “Download” button will be enabled and the flash update process can start.
The download process will connect at a higher speed to the EasyVR module, so the “bridge” program running on your host device might not work (in particular Robonova and Basic Stamp cannot be used for this purpose) and you might need a true “serial adapter”.

The full speed used is 230400 bps, but the option “Slow transfer” can be used to reduce it to 115200, for better compatibility with slower serial adapters. One adapter that can go to full speed is the EasyVR DevBoard or the SmartVR DevBoard. Otherwise any USB/Serial adapter with TTL/CMOS interface can be used for updating the flash. The EasyVR Shield can be used for the download, provided that the jumper (J12) is in UP position.

Note: Every download will overwrite the previously transferred custom data.

After the download completes, a new connection can be established with the EasyVR module (in “normal-mode”) and the new sounds will be displayed by the EasyVR Commander, in the special group “SoundTable” (the last one in the list with a yellow icon). They can be played back and tested using the “Play Sound” command on the toolbar or in the “Tools” menu. See also how to do that in your application in the code example Use custom sound playback.

Custom grammars will be displayed just after the built-in word sets and they work exactly the same way. Trigger words, when specified, will have their own vocabulary with only one entry. You can test and use the custom trigger and command grammars as you do with the built-in ones.

Note: The built-in trigger word set is handled in a special way, as it is active also when recognizing from the first user defined command group. This is the only case where SD and SI commands are mixed together and does not apply to custom trigger vocabularies.

---

6 Arduino UNO (and other boards with USB/Serial adapter based on ATMEGA8U2) need the option “Slow transfer” enabled
Updating Firmware

The EasyVR firmware can be updated in a similar way to custom data by using the command “Update Firmware...” from the “Help” menu. Note that you must first disconnect from the module and do the steps required to start it in “boot-mode” (see the section Flash Update).

The specified file will be verified as an official firmware release and basic version information will be displayed. If the firmware passes the verification step, then the “Download” button will be enabled.

![Figure 83 - Interface for updating EasyVR firmware](image)

Note: After a new firmware is downloaded to the module, the custom data already present is erased and it must be downloaded again if necessary.

Troubleshooting

Downloading custom data or update fails

1. Double check your settings (COM Port selection; Jumper position)
2. Try to enable the option “Slow transfer”
3. Use an USB to TTL adapter connected directly to the EasyVR module
How to get support

Please feel free to contact us with any questions, queries or suggestions. If your question is about technical support or troubleshooting for one of our products, we kindly ask you to first check our FAQ for a possible solution: http://www.veear.eu/faq

If you cannot find an existing solution on the FAQ, please contact us using the contact form on our website at http://www.veear.eu/support. The more detail you provide, the better support we can give.

VeeaR © RoboTech srl, all rights reserved.

All VeeaR branded boards and software are manufactured by RoboTech srl

RoboTech srl assumes no responsibility for any errors, which may appear in this manual. Furthermore, RoboTech srl reserves the right to alter the hardware, software, and/or specifications detailed herein at any time without notice, and does not make any commitment to update the information contained herein. RoboTech srl products are not authorized for use as critical components in life support devices or systems.